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Warranty /  
Sof tware  L icense  

Part Number 6002773 / Revision R / April 2023 

Copyright ©TSI Incorporated / 2009-2023 / All rights reserved. 

Address TSI Incorporated / 500 Cardigan Road / Shoreview, MN  55126 / USA 

E-mail Address answers@tsi.com  

Limitation of Warranty 

and Liability 

(effective April 2014) 

 

(For country-specific terms and conditions outside of the USA, please visit www.tsi.com.) 

Seller warrants the goods, excluding software, sold hereunder, under normal use and service as 

described in the operator's manual, to be free from defects in workmanship and material for 12 

months, or if less, the length of time specified in the operator's manual, from the date of 

shipment to the customer. This warranty period is inclusive of any statutory warranty. This 

limited warranty is subject to the following exclusions and exceptions:   

a. Hot-wire or hot-film sensors used with research anemometers, and certain other components 
when indicated in specifications, are warranted for 90 days from the date of shipment;  

b. Pumps are warranted for hours of operation as set forth in product or operator’s manuals; 

c. Parts repaired or replaced as a result of repair services are warranted to be free from defects in 
workmanship and material, under normal use, for 90 days from the date of shipment;  

d. Seller does not provide any warranty on finished goods manufactured by others or on any fuses, 
batteries or other consumable materials. Only the original manufacturer's warranty applies; 

e. This warranty does not cover calibration requirements, and seller warrants only that the 
instrument or product is properly calibrated at the time of its manufacture. Instruments 
returned for calibration are not covered by this warranty;   

f. This warranty is VOID if the instrument is opened by anyone other than a factory authorized 
service center with the one exception where requirements set forth in the manual allow an 
operator to replace consumables or perform recommended cleaning;   

g. This warranty is VOID if the product has been misused, neglected, subjected to accidental or 
intentional damage, or is not properly installed, maintained, or cleaned according to the 
requirements of the manual. Unless specifically authorized in a separate writing by Seller, Seller 
makes no warranty with respect to, and shall have no liability in connection with, goods which 
are incorporated into other products or equipment, or which are modified by any person other 
than Seller.  

The foregoing is IN LIEU OF all other warranties and is subject to the LIMITATIONS stated herein. 
NO OTHER EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR PARTICULAR PURPOSE 
OR MERCHANTABILITY IS MADE. WITH RESPECT TO SELLER’S BREACH OF THE IMPLIED 
WARRANTY AGAINST INFRINGEMENT, SAID WARRANTY IS LIMITED TO CLAIMS OF 
DIRECT INFRINGEMENT AND EXCLUDES CLAIMS OF CONTRIBUTORY OR INDUCED 
INFRINGEMENTS. BUYER’S EXCLUSIVE REMEDY SHALL BE THE RETURN OF THE 
PURCHASE PRICE DISCOUNTED FOR REASONABLE WEAR AND TEAR OR AT SELLER’S 
OPTION REPLACEMENT OF THE GOODS WITH NON-INFRINGING GOODS.  

TO THE EXTENT PERMITTED BY LAW, THE EXCLUSIVE REMEDY OF THE USER OR 
BUYER, AND THE LIMIT OF SELLER'S LIABILITY FOR ANY AND ALL LOSSES, INJURIES, 
OR DAMAGES CONCERNING THE GOODS (INCLUDING CLAIMS BASED ON CONTRACT, 
NEGLIGENCE, TORT, STRICT LIABILITY OR OTHERWISE) SHALL BE THE RETURN OF 
GOODS TO SELLER AND THE REFUND OF THE PURCHASE PRICE, OR, AT THE OPTION 
OF SELLER, THE REPAIR OR REPLACEMENT OF THE GOODS. IN THE CASE OF 
SOFTWARE, SELLER WILL REPAIR OR REPLACE DEFECTIVE SOFTWARE OR IF UNABLE 
TO DO SO, WILL REFUND THE PURCHASE PRICE OF THE SOFTWARE. IN NO EVENT 
SHALL SELLER BE LIABLE FOR LOST PROFITS, BUSINESS INTERRUPTION, OR ANY 
SPECIAL, INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES. SELLER SHALL NOT 
BE RESPONSIBLE FOR INSTALLATION, DISMANTLING OR REINSTALLATION COSTS OR 
CHARGES. No Action, regardless of form, may be brought against Seller more than 12 months 
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after a cause of action has accrued. The goods returned under warranty to Seller's factory shall 
be at Buyer's risk of loss, and will be returned, if at all, at Seller's risk of loss. 

Buyer and all users are deemed to have accepted this LIMITATION OF WARRANTY AND 
LIABILITY, which contains the complete and exclusive limited warranty of Seller. This LIMITATION 
OF WARRANTY AND LIABILITY may not be amended, modified or its terms waived, except by 
writing signed by an Officer of Seller. 

Service Policy Knowing that inoperative or defective instruments are as detrimental to TSI as they are to our 
customers, our service policy is designed to give prompt attention to any problems. If any mal-
function is discovered, please contact your nearest sales office or representative, or call TSI’s 
Customer Service department at 1-800-680-1220 (USA) or +001 (651) 490-2860 (International). 

Software License  READ THE TERMS OF THIS AGREEMENT AND ANY PROVIDED SUPPLEMENTAL LICENSE 
TERMS (COLLECTIVELY "AGREEMENT") CAREFULLY BEFORE OPENING THE 
SOFTWARE MEDIA PACKAGE. BY OPENING THE SOFTWARE MEDIA PACKAGE, YOU 
AGREE TO THE TERMS OF THIS AGREEMENT. IF YOU ARE ACCESSING THE SOFTWARE 
ELECTRONICALLY INDICATE YOUR ACCEPTANCE  

OF THESE TERMS BY SELECTING THE "ACCEPT" or "YES" BUTTON AT THE END OF THIS 
AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THESE TERMS, PROMPTLY RETURN 
THE UNUSED SOFTWARE TO YOUR PLACE OF PURCHASE FOR A REFUND OR, IF THE 
SOFTWARE IS ACCESSED ELECTRONICALLY, SELECT THE "CANCEL" or "NO" BUTTON 
AT THE END OF THIS AGREEMENT. 

THE LICENSE 

TSI Inc., of 500 Cardigan Road, Shoreview, MN 55126 (the “Licensor” which expression shall 
include its subsidiaries, agents, successors and assigns) is authorized to license the software 
(the “Software”) and the Licensee accepts a non-exclusive, non-transferable License to “Use” 
(as hereinafter defined) the Software on a single computer system (the “System”) for single use 
or by the maximum number of concurrent users specified below upon the terms and subject to 
the conditions contained herein. Where the Software is issued in multi-media, multi-disk format 
(being either different disk size or different system compatibility) only that format which is 
compatible with the System may be used. The other format may not be used and should be 
destroyed.  
 
This License entitles the Licensee to: 
 
(a)  load, install and Use the Software contained in this package on either (as appropriate to 

the Licensee’s system) one Central Processing Unit (“CPU”) of the System (a separate 
license fee being required for each CPU upon which the Licensee wishes to use the 
Software), or, if the Licensee’s System is multi-user, by a maximum of concurrent users 
specified in the license key; 

(b)  Use the Software in accordance with the provisions of Clause 2 of this License; 
 
and to: 
 
(a) receive the Licensor’s bulletin reports of errors and “patches” and receive such new 

updates of the Software incorporating the same; 
(b)  receive information on upgraded versions of the Software at such cost (if any) as may be 

notified to the Licensee. 

1. Acceptance of this License  

The terms and conditions of this License are deemed to be accepted by the parties by the 
Licensor upon dispatch/delivery by the Licensor of specified software to the Licensee direct or to 
the Licensor’s agent as the case may be; 

2. Use of the Software 

(a) For the purposes of this License “Use” shall mean and include: 
(i) utilization of the Software by copying, transmitting, or loading the same into the 

temporary memory (RAM) or installing into the permanent memory (e.g. hard disk, 
CD ROM or other storage device) of the System for the processing of the System 
instructions or statements contained in such Software; 

(ii) copying the Software which is in machine-readable form for Use by the Licensee 
on the System for the purposes only of understanding the contents of such 
machine-readable material and for back-up provided that no more than two (2) 
copies will be in existence under any License at any one time without prior written 
consent from the Licensor or as otherwise permitted by the applicable law; 

(iii) merging the whole or any part of the Software in machine-readable form into 
another software program; 
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(iv) storing the whole or any part of the Software on the System or other storage unit or 
disk; 

(v) utilizing (but not copying) the instructional and/or operational manuals relating to 
the Software. 

(b) For the purposes of this License “concurrent use” shall mean simultaneous use of the 
Software by the number of users of the License specified above PROVIDED however that 
Software installed on a file server for the sole purpose of distribution to other workstations 
or computers is not being Used for the purposes of ascertaining the number of concurrent 
users. Additional concurrent users may only be added by signing a separate license 
agreement with the Licensor.  

3. License Fee 

(a) Where the License Fee is not paid by the Licensee at the time the Software is obtained 
from the Licensor or its agent the license fee will be payable within the number of days 
specified in the Licensor’s invoice unless otherwise agreed in writing by the Licensor. 

(b) An additional License Fee is payable for each CPU of the System upon which the Licensee 
wishes to Use the Software or in respect of additional concurrent users in excess of the 
maximum number specified above. In the event that the Licensee’s System is inoperable 
or requires or is under repair, the Licensee shall be permitted to Use the Software on a 
back-up system at no extra charge, until the System is operational. 

4. Licensee’s Undertakings 

(a) The Licensee undertakes not to perform any of the acts referred to in this sub-clause (a) 
except to the extent and only to the extent permitted by the applicable law to the Licensee 
as a lawful user (i.e. a party with a right to use) of the Software and only then for the 
specific limited purpose stated in such applicable law or hereunder. The Licensee 
undertakes: 
(i) not to copy the Software (other than for normal System operation and as specified 

in Clause 2 above) not otherwise reproduce the same Provided that the Licensee 
may copy the Software for backup purposes or incidentally, in the course of 
converting the Software in accordance with 4(a)(iii) below; 

(ii) not to translate, adapt, vary, modify, the Software 
(iii) not to disassemble, decompile or reverse engineer the Software Provided however 

that in the case of decompilation, the Licensee may incidentally decompile the 
Software only if it is essential to do so in order to achieve interoperability of the 
Software with another software program (“Permitted Purpose”) and provided the 
information obtained by the Licensee during such decompilation is only used for the 
Permitted Purpose and is not disclosed or communicated to any third party whom it 
is not necessary to disclose or communicate such information without the 
Licensor’s prior written consent and is not used to create any software which is 
substantially similar to the expression of the Software nor used in any manner 
which would be restricted by copyright. 

 
The Licensee undertakes: 
 
(b) to maintain accurate and up-to-date records of the number and location of all copies of the 

Software. 
(c) to supervise and control Use of the Software in accordance with the terms of this License. 
(d) to ensure that its employees, agents and other parties who will use the Software are 

notified of this License and the terms hereof prior to such employee, agent or party using 
the same. 

(e) to reproduce and include the copyright notice on of the Licensor or such other party as may 
be specified in or on the Software (the “Owner”) on all and any copies, whether in whole or 
in part, in any form, including partial copies or modifications of the Software made herein. 

(f) not to provide or otherwise make available the Software in whole or in part (including 
where applicable, but not limited to program listings, object code and source program 
listings, object code and source code), in any form to any person other than the Licensee’s 
employees or as specified in (d) above without prior written consent from the Licensor.  

(g) within 14 days after the date of termination or discontinuance of this License for whatever 
reason, to destroy the Software and all updates, upgrades or copies, in whole and in part, 
in any form including partial copies or modifications of the Software received from the 
Licensor or made in connection with this License, and all documentation relating thereto. 

5. Warranty 

(a) The Licensee acknowledges that software in general is not error-free and agrees that the 
existence of such errors shall not constitute a breach of this License. 

(b)  To the extent permitted by the applicable law, the Licensor disclaims all other warranties 
with respect to the Software, either express or implied, including but not limited to any 
implied warranties of merchantability or fitness for any particular purpose. 



vi FMS Software User’s Manual 

(c) Although the Licensor does not warrant that the Software supplied hereunder shall be free 
from all known viruses it has used commercially reasonable efforts to check for the most 
commonly known viruses prior to packaging but the Licensee is solely responsible for virus 
scanning the Software. 

(d) The Licensor warrants that there are no disabling programs or devices in the Software. 
(e) Unless otherwise declared by the parties in writing, the Licensor represents and warrants 

that the Software provided and/or Deliverables prepared pursuant to this License will not 
contain any “Open Source”. For purposes of this License “open Source” means any 
software code that (f) contains, or is derived in any manner (in whole or in part) from any 
software that is distributed as free software, open source software, shareware (e.g. Linux), 
or similar licensing or distribution models, (ii) is subject to any agreement with terms 
requiring that such software code be (A) disclosed or distributed in source code or object 
code form, (B) licensed for the purpose of making derivation works, or (C) redistributable. 
Open Source includes, but is not limited to, software licensed or distributed under any of 
the following licenses or distribution models, or licenses or distribution models similar to 
any of the follows: (a)GNU’s General Public License (GPL) or Lesser/Library GPL (LGPL); 
(b) the Artistic License (e.g., PERL); (c) the Mozilla Public License(s); (d) the Netscape 
Public License; (e) the Berkeley software design (BSD) license including Free BSD or 
BSD-style license; (f) the Sun Community Source License (SCSL); (g) an Open Source 
Foundation License (e.g., CDE and Motif UNIX user interfaces); (h) the Apache Server 
license; and (i) any licenses listed at www.opensource.org/licenses. 

 
WARRANTY DISCLAIMER. THE EXPRESS WARRANTIES CONTAINED IN THIS 
AGREEMENT ARE IN LIEU OF ALL OTHER WARRANTIES, REPRESENTATIONS AND 
GUARANTEES OF ANY KIND BY THE LICENSOR, INCLUDING BUT NOT LIMITED TO ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR PARTICULAR 
PURPOSE. EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, ALL PRODUCTS, 
SERVICES AND OTHER MATERIALS (IF ANY) ARE FURNISHED BY THE LICENSOR AND 
ACCEPTED BY THE LICENSEE “AS IS”. ALL OTHER WARRANTIES, WHETHER 
STATUTORY, EXPRESS OR IMPLIED, ARE SPECIFICALLY EXCLUDED AND DISCLAIMED 
BY THE LICENSOR, INCLUDING WITHOUT LIMITATION ANY IMPLIED OR OTHER 
WARRANTIES OF OR AGAINST: (1) INTERFERENCE WITH QUIET ENJOYMENT, NON-
INFRINGEMENT, WORKMANLIKE EFFORT, QUALITY, ACCURACY, TIMELINESS, 
COMPLETENESS, TITLE, COMPATIBILITY, INTEGRATION, NO ENCUMBRANCES, NO 
LIENS, TITLE, MERCHANTIBILITY OR FITNESS FOR ANY PARTICULAR PURPOSE, (2) 
THAT ANY PRODUCTS, SERVICES OR OTHER MATERIALS WILL CONFORM TO ANY 
DEMONSTRATION OR PROMISE BY THE LICENSOR, OR (3) THAT MAY ARISE THROUGH 
ANY COURSE OF DEALING BETWEEN THE PARTIES. 
 
THE LICENSOR DOES NOT WARRANT THAT THE PRODUCTS, SERVICES OR ANY 
OTHER MATERIALS PROVIDED HEREUNDER WILL MEET THE LICENSEE’S 
REQUIREMENTS OR THAT THEY OR THEIR ACCESS OR USE WILL BE UNINTERRUPTED, 
ERROR FREE, OR COMPLETELY SECURE. EXCEPT AS EXPRESSLY PROVIDED IN THIS 
CLAUSE, THE ENTIRE RISK AS TO THE PRODUCTS, SERVICES AND ANY OTHER 
MATERIALS PROVIDED BY THE LICENSOR IS WITH THE LICENSEE, INCLUDING FOR 
QUALITY AND PERFORMANCE AND FOR ACCURACY OR QUALITY OF ANY 
INFORMATION TRANSMITTED, RECEIVED OR OTHERWISE DELIVERED VIA THE 
PRODUCTS AND SERVICES. 

6. Licensor’s Liability 
(a) The Licensor shall not be liable to the Licensee for any loss or damage whatsoever or 

howsoever caused arising directly or indirectly in connection with this License, the 
Software, its use or otherwise, except to the extent that such liability may not be lawfully 
excluded under the applicable law. 

(b) Notwithstanding the generality of (a) above, the Licensor expressly excludes liability for 
indirect, special, incidental or consequential loss or damage which may arise in respect of 
the Software, its use, the System or in respect of other equipment or property, or for loss of 
profit, business, revenue, goodwill or anticipated savings. 

(c)   In the event that any exclusion contained in this License shall be held to be invalid for any 
reason and the Licensor becomes liable for loss or damage that may lawfully be limited, 
such liability shall be limited to the license fee paid by the Licensee for the Software. 

(d) The Licensor does not exclude liability for death or personal injury to the extent only that 
the same arises as a result of the negligence of the Licensor, its employees, agents or 
authorized representatives. 

7. Copyright, Patents, Trade Marks and Other Intellectual Property Rights 
The Licensee acknowledges that any and all of the copyright, trademarks, trade names, patents 
and other intellectual property rights subsisting in or used or in connection with the Software 
including all documentation and manuals relating thereto are and remain the sole property of the 
Licensor and/or the Owner. The Licensee shall not during or at any time after the expiry or 

http://www.opensource.org/licenses
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termination of this License in any way question or dispute the ownership by the Licensor and/or 
the Owner thereof. 

8. Indemnity 
(a) The Licensor agrees to indemnify and save harmless and defend at its own expense the 

Licensee from and against any and all claims of infringement of any patent, trade mark, 
industrial design, copyright or other proprietary right affecting the Software PROVIDED 
THAT  (i) the Licensee shall not have done, permitted or suffered to be done anything 
which may have been or become an infringement of any such rights (including but not 
limited to using the Software to perform the Licensee’s or other party’s applications or 
using the Software in combination or merged with other software programs or devices) and 
(ii) the Licensee shall have exercised a reasonable standard of care in protecting the 
same; failing which, the Licensee shall indemnify the Licensor against all actions, 
proceedings, costs, claims and expenses incurred in respect thereof. 

(b) The Licensee undertakes that the Licensor shall be given prompt notice of any claim 
specified in (a) above that is made against the Licensee and the Licensor shall have the 
right to defend any such claims and make settlements thereof at its own discretion and the 
Licensee shall give such assistance as the Licensor may reasonably require to settle or 
oppose any such claims. 

(c) In the event that any such infringement occurs or may occur, the Licensor may at its sole 
option and expense: 
(i) procure for the Licensee the right to continue using the Software or infringing part 

thereof; or 
(ii) modify or amend the Software or infringing part thereof so that the same becomes 

non-infringing; or 
(iii) replace the Software or infringing part thereof by other software or similar 

capability; or 
(iv) repay to the Licensee the License fee or balance thereof relating to the whole or 

the infringing part of the Software. 
(d) The Licensor’s liability under this clause shall, at the Licensor’s option, be limited to the 

License fee less an equitable proportion thereof as relates to the period prior to cessation 
owing to infringement. 

9. Confidential Information 
(a) All information, data, drawings, specifications, documentation, software listings, source or 

object code with the Licensor may have imparted and may from time to time impart to the 
Licensee relating to the Software (other than the ideas and principles which underlie the 
Software) is proprietary and confidential. The Licensee hereby agrees that it shall use the 
same solely in accordance with the provisions of this License and that it shall not at any 
time during or after expiry or termination of this License, disclose the same, whether 
directly or indirectly, to any third party without the Licensor’s prior written consent. 

(b) Subject only to the specific, limited provisions of Clause 4(a) above, the Licensee further 
agrees that it shall not itself or through any subsidiary, agent or third party use such 
confidential information to copy, reproduce, translate, adapt, vary, modify, decompile, 
disassemble or reverse engineer the Software nor shall the Licensee sell, lease, license, 
sub-license or otherwise deal with the Software or any part or parts or variations, 
modifications, copies, releases, versions or enhancements thereof or have any software or 
other program written or developed for itself based on any confidential information supplied 
to it by the Licensor. 

(c)  The foregoing provisions shall not prevent the disclosure or use by the Licensee of any 
information which is or hereafter, through no fault of the Licensee, becomes public 
knowledge or to the extent permitted by law. 

10. Force Majeure 
The Licensor shall be under no liability to the Licensee in respect of anything which, apart from 
this provision, may constitute a breach of this License arising by reason of acts of war (declared 
or undeclared), terrorism, force majeure.  

11. Termination  
(a) In addition to provisions for termination as herein provided, the Licensor may by notice in 

writing to the Licensee terminate this License if the Licensee is in breach of any term, 
condition or provision of this License or required by the applicable law and fails to remedy 
such breach (if capable of remedy) within 30 days of having received written notice from 
the Licensor specifying such breach. 

(b) Upon termination, the Licensee shall pay to the Licensor all costs and expenses, including 
legal and other fees incurred and all arrears of fees, charges or other payments arising in 
respect of the Software, this License or otherwise and shall comply with its undertaking 
specified in Clause 4(g) above. 

(c) Termination, howsoever or whenever occasioned shall be subject to any rights and remedies 
the Licensor may have under this License or under the applicable law.  
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12. Assignment 
The Licensee shall not assign or otherwise transfer all or any part of the Software or this 
License without the prior written consent of the Licensor. 

13. Waiver 
Failure or neglect by either party to enforce at any time any of the provisions hereof shall not be 
construed nor shall be deemed to be a waiver of that party’s rights hereunder nor in any way 
affect the validity of the whole or any part of this License nor prejudice that party’s rights to take 
subsequent action. 

14. Headings 
The headings of the terms and conditions herein contained are inserted for convenience of 
reference only and are not intended to be part of or to affect the meaning or interpretation of any 
of the terms and conditions of this License. 

15. Severability  
In the event that any of these terms and conditions or provisions shall be determined by any 
competent authority to be invalid, unlawful or unenforceable to any extent, such term, condition 
or provision shall to that extent be severed from the remaining terms, conditions and provisions 
which shall continue to be valid to the fullest extent permitted by law. 

16. Governing Law  
The parties hereby agree that the License concluded between them and constituted on these 
terms and conditions shall be construed in accordance with American and British law. For 
inquiries, please contact: TSI Incorporated, 500 Cardigan Road, Shoreview, MN 55126, 1-800-
874-2811 or 1-651-490-2811. 

PostgreSQL End User  
License Agreement  

Note, as an end user of FMS software, if you install the PostgreSQL database, you are 
responsible for these End User License Agreement conditions: 

PostgreSQL Database Management System (formerly known as Postgres, then as Postgres95) 
Portions Copyright (c) 1996-2011, PostgreSQL Global Development Group 
Portions Copyright (c) 1994, The Regents of the University of California 

Permission to use, copy, modify, and distribute this software and its documentation for any 
purpose, without fee, and without a written agreement is hereby granted, provided that the 
above copyright notice and this paragraph and the following two paragraphs appear in all copies. 

IN NO EVENT SHALL THE UNIVERSITY OF CALIFORNIA BE LIABLE TO ANY PARTY FOR 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, INCLUDING 
LOST PROFITS, ARISING OUT OF THE USE OF THIS SOFTWARE AND ITS 
DOCUMENTATION, EVEN IF THE UNIVERSITY OF CALIFORNIA HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE. 

THE UNIVERSITY OF CALIFORNIA SPECIFICALLY DISCLAIMS ANY WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE. THE SOFTWARE PROVIDED HEREUNDER 
IS ON AN "AS IS" BASIS, AND THE UNIVERSITY OF CALIFORNIA HAS NO OBLIGATIONS 
TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR 
MODIFICATIONS.  
 

Trademarks TSI and the TSI logo are trademarks of TSI Incorporated in the United States and may be 
protected under other country’s trademark registrations.  

Microsoft, Windows, Internet Explorer, MS SQL, and SQL Server are registered trademarks 
of Microsoft Corporation.  

Modbus is a registered trademark of Modbus Organization, Inc.  

Netscape is a registered trademark of Netscape Communications Corporation.  

Mozilla and Firefox are registered trademarks of the Mozilla Foundation.  

Opera is a registered trademark of Opera Software ASA. 

Java is a trademark of Sun Microsystems, Inc. 

Linux is a registered trademark of Linus Torvalds. 

Oracle and MySQL are registered trademarks of Oracle and/or its affiliates. 

HP LaserJet is a registered trademark of Hewlett Packard Corporation. 

Adobe, Acrobat, and Reader are registered trademarks of Adobe Systems Incorporated in 
the United States and/or other countries. 

UNIX is a registered trademark of The Open Group. 

PostgreSQL is a registered trademark of PostgreSQL Global Development Group. 
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About  This  Manual  

P u r p o s e  

This manual is intended for users of FMS software. How to use the various 

features of FMS are described in this manual.  

G e t t i n g  H e l p  

To obtain assistance for this software or to submit suggestions, please 

contact Controlled Environments: 

 

TSI Incorporated 

500 Cardigan Road 

Shoreview, MN  55126  USA 

Fax:  (651) 490-3824 

Telephone:  1-800-680-1220 (USA) or (651) 490-2860 

E-mail:  technical.services@tsi.com 

S u b m i t t i n g  C o m m e n t s  

TSI® values your comments and suggestions on this manual. Please use the 

comment sheet, on the last page of this manual, to send us your opinion on 

the manual’s usability, to suggest specific improvements, or to report any 

technical errors. 

 

If the comment sheet has already been used, mail or fax your comments on 

another sheet of paper to: 

 

TSI Incorporated 

Controlled Environments 

500 Cardigan Road 

Shoreview, MN 55126 

Fax:  (651) 490-3824 

E-mail Address: answers@tsi.com   

mailto:technical.services@tsi.com
mailto:answers@tsi.com
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C H A P T E R  1  
In t roduct ion  

FMS is a client server application. It is made up of different programs that 

communicate with each other over TCP/IP networks. Each separate program 

performs a limited set of tasks. However, powerful systems can be built by 

connecting the components together.  

 

FMS has the following programs:  

 

 The Monitoring 

Engine Server 

Controls equipment, collects data from the equipment, stores 

the results in a database, and detects alarm conditions. It 

performs various actions in response to a range of events. 

 The User 

Interface 

This application displays the status of the system, the 

configuration of monitoring and OPC UA servers can be 

controlled, and reports can be generated from the data stored 

on the SQL database. 

 The OPC UA 

Server 

This application exposes an OPC UA Server address space 

containing many of the FMS node sample points. 

 A SQL Database 

Server 

The SQL server is the application that stores the collected 

data. There are several types of SQL servers. FMS has been 

tested using Microsoft® SQL and PostgreSQL® software. 

Applications other than FMS can also access a SQL server to 

generate reports. SQL servers usually have comprehensive 

security features to control access and can include encryption. 

 

Although there are several different programs, only the client application has 

a user interface. The other applications are run in the background without 

needing to display any data. This means a whole system can run on just one 

computer. However, it is possible for each component to run on a different 

computer, often there are advantages to running the SQL server on a 

different computer.  

 

It is possible to have more than one monitoring server running. This can be 

on one or more computers; for example, one monitoring server controlling 

particle counters and a second server controlling environmental sensors.  

 

A single SQL server can be shared with many monitoring servers.  

 

Each client can see all monitoring servers on a network.  
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G l o s s a r y  

FMS Facility Monitoring System 

FMS Software of Facility Monitoring Systems Limited 

FS Functional Specification 

GAMP Good Automated Manufacturing Practice 

ISPE International Society for Pharmaceutical Engineering 

IQ Installation Qualification 

OQ Operational Qualification 

SQL Structured Query Language 

OPC UA OPC Unified Architecture 

21 CFR Part 11 21 Code of Federal Regulations - Electronic Records; 

Electronic Signatures 
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C H A P T E R  2  

Insta l l ing  the  Sof tware  

I n s t a l l i n g  F M S  S o f t w a r e  a n d  P o s t g r e S Q L ®  
D a t a b a s e   

• License keys for FMS software should have been supplied.  

• The following instructions assume that FMS software is being installed 

from an Install CD or DVD. If not, open the required files directly from 

the network.  

• In the following instructions the name of the database will be FMS01, 

the Client User will be named “Client”, the Monitor User will be 

named “Monitor”.  

• FMS software can be run on Windows® 10 Professional Edition or 

above, Windows® 11 Professional Edition or above, Windows® Server 

2008 with R2 package, Windows® Server 2012 with R2 package 

operating systems, Windows® Server 2016, or Windows® Server 2019.  

• Please refer to the FMS installation guide for installation details.  

S Q L  S e r v e r s  

FMS requires a SQL server for storing data. This server can be on the same 

computer as the monitoring system, the client system or, it can reside on 

another computer.  

 

Each SQL server has its own requirements for installation and setting up.  

 

 N O T I C E  

 It is necessary to read the SQL server's documentation to configure 

databases and user accounts correctly especially when setting host access 

and user privileges. 

                                                      

PostgreSQL is a registered trademark of PostgreSQL Global Development Group.  
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Any SQL server used with FMS must support the ALTER TABLE, 

CREATE TABLE, CREATE INDEX, and SELECT ... LIMIT commands. The 

SQL servers must support quoted identifiers by default. This may require 

altering the database server configuration. Many databases allow quoted 

identifiers by default, others do not (Microsoft® SQL Server® database 

software).  

The following SQL servers are known to work with FMS, PostgreSQL and 

MS SQL® server.  

 

It is important that databases are enabled to use ANSI quoting.  

 

PostgreSQL Databases can be accessed directly and MS SQL ® through 

ODBC. If ODBC is used, ODBC connections must be set up on each 

computer where either FMS Client or monitor is running. 

O n - l i n e  H e l p  

There is on line help accessible by selecting the Help menu option or by 

pressing the Help buttons.  
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C H A P T E R  3  
System Maintenance  

The following routine system maintenance tasks should be performed every 

few weeks.  

C h e c k  F r e e  D i s k  S p a c e  

Data records can be saved to local disk drives, to networked disk drives 

and/or to a SQL server. If disk space runs out, results can no longer be 

recorded. It is important to ensure this does not happen. 

 

Problems may arise with determining exactly where data is being saved. 

Directories may be networked drives or links to other directories on different 

drives/network locations. In the case of storing results on a SQL server, 

access to the computer where the results are stored, might not be possible 

at all. 

 

Free space on a networked system drive may be difficult to determine, as 

each user may have a different permitted level of allocated space. 

 

Depending on how a system is configured, it is not possible to give a specific 

command script. Normally a site specific procedure is required to ensure that 

there is enough disk space. 
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S h u t d o w n  a n d  R e b o o t   

Only during operating system start-up can a hard disk be correctly checked 

and the file system repaired safely. Further applications and operating 

system functions might slowly leak resources. 

For these reasons a system should be shut down and rebooted every few 

weeks, if possible once per week.  

R o b u s t n e s s  F e a t u r e s  

FMS has several functions to improve the robustness of the system. The 

Guard service can monitor applications and recover from an application 

crashing or becoming “stuck”. 

 

G u a r d  S e r v i c e  

The Guard service is installed to start and control the monitoring tasks 

(nodes). These programs run in the background and have no user interface. 

On starting, the Guard service reads the file Guard.ini and runs the 

programs listed in it. If any of the programs fails, it is restarted. Each time the 

program fails, the time between restarts doubles up to a maximum of 60 

seconds. If a program runs for more than one hour without failure, the restart 

time is reduced to one second. Additionally, the Guard service ensures every 

monitoring task is running correctly by requiring a watchdog clear message, 

a line of text printed on the standard error channel, to be sent from the 

program to the Guard service at least once every two minutes. If there is no 

watchdog clear message from the task, the guard process kills and restarts 

the program.  

A r c h i v i n g  

General Notes 

As results are written to a SQL database such as PostgreSQL software, it is 

possible to archive (dump) a database while it is in use in a safe manner. 

Refer to the database documentation. 
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It makes sense to archive a system at the same time as a routine shutdown 

and reboot. 

Although SQL commands are almost the same between servers, there can 

be some differences. The main difference is the type of the date time field. 

This is important when transferring SQL journal files between different 

SQL servers. 

FMS uses memory mapped files. It is possible for some archiving programs 

to interfere with these files by locking them. This in turn can cause FMS to 

fail. Therefore, it is recommended that FMS is disabled/stopped 

during archiving.  

Options for Archiving 

FMS provides various facilities for archiving results in a useful form. The 

options are listed below.  

SQL Journal Files The SQL database can be enabled to write a copy of 

the SQL commands to file on a one file per day basis.  

The directory for storing these files can be on a 

network server. As these are daily files there is no 

issue with respect to archiving these files while the 

system is running. 

Using Old Data Data that is considered no longer required can be 

archived and removed from the database. This is a 

SQL server dependent process. 

If archived data is needed, it is best to restore it to a 

separate computer. If the node configuration from the 

original system is renamed appropriately (for 

example, “Node01” might be renamed 

“Node01Archive”) and all units disabled in the 

configuration, it is then possible to create a node that 

has only the archived data and does not collect any 

data. All the reporting functions will work as expected. 

The local node configuration will also need to be 

altered to match the different database. 

PC Maintenance 

Many apparent software problems are caused by faults in the hardware. The 

most common of these are: 

CMOS Battery 

Exhaustion 

This causes the PC's clock to behave erratically and can 

cause other “strange” behaviors. It is recommended that 

the CMOS battery be replaced every year. FMS will reset 

automatically if the clock advances by more than 1 minute 

or reduces by more than 1 second. 
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RAM Faulty RAM causes programs to crash. It requires only 

one cell to fail (in billions) to make a program crash. A 

typical symptom of this problem is where an application 

fails when a particular function is called and the problem 

cannot be reproduced elsewhere and it disappears when 

the RAM is replaced. 

D a y l i g h t  S a v i n g s  T i m e  

Daylight Savings Time adjustments are often made twice per year. This 

usually involves advancing the clock by one hour in the Spring and reversing 

the clock by one hour in the Fall.  

 

This can cause problems when recording results, such as, during the Spring 

change there appears to be an hour's worth of data missing and in the Fall 

the values for one hour have multiple readings, unless the database is time 

zone aware.  

 

It is suggested that automatic Daylight Savings adjustments are disabled 

and that they are manually applied when necessary. Monitoring should be 

stopped before the clock change and restarted after the clock change. 

 

FMS will automatically stop and restart monitoring if any date changes are 

detected or time changes of greater than one minute. Under Microsoft® 

Windows®, the act of opening the calendar can immediately change the time 

which can in turn cause FMS to stop and start. 

2 1  C F R  P a r t  1 1  C o m p l i a n c e  

FMS was developed with 21 CFR Part 11 (21 CFR 11) in mind. 21 CFR 11 is 

a set of United States of America Federal Regulations that cover the security 

of digital records. This feature is enabled when FMS is installed in 

Pharma mode. 

The key concepts behind these regulations are non-repudiation and data 

security. That is, with a compliant system it is difficult to claim that a record 

was falsified and that any data records be difficult to modify without detection 

and that the data be readable over a long period of time. 

Software by itself cannot be 21 CFR Part 11 compliant, as it is whole 

systems that include equipment, people, and company structures that are 

involved in compliance. 



 

System Maintenance 3–5 

FMS has the following features that can be enabled to assist an end user to 

comply with 21 CFR 11:  

• A username and password are required for access to FMS applications.  

• Passwords can be aged so they must be renewed at a selected interval.  

• Users can be restricted to the functions they have access to.  

• After a period of inactivity users can be logged off automatically. 

• Terminals can be locked after a selected number of failed logins. 

• Auditing can be enabled to log every user action that changes a 

configuration. The audit trail includes the item changed, the nature of the 

change, the full user description of the user who made the change and 

the user ID of the person making the change.  

• Before any change to a configuration is allowed the user's password and 

a comment can be required.  

• User actions (e.g., alarm acknowledgement) require the user's password 

and are logged with the user's description and user's ID.  

• When saving a configuration, the configuration is saved under the given 

name as well as under the given name plus the date and time. That is a 

time stamped archive copy of a configuration is made every time a 

configuration is saved.  

• When auditing is enabled the new and previous values of any changed 

attribute is recorded.  

• SQL Servers can be made secure and use encryption.  
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C H A P T E R  4  
FMS Cl ient  

The FMS Client application includes facilities to view, configure, and to 

control monitoring systems. A client can access many monitoring systems at 

a time. When the client application starts, all accessible monitoring systems 

are detected and displayed in the Node tab. The client application uses 

loadable modules to perform various functions.  

H e l p  

There are several layers of help available as listed in this section. 

Fly By Hints 

Fly By Hints are short prompts that are displayed by putting the mouse 

cursor over an item. These usually briefly describe what the item is for and 

does. Almost all items have a Fly By Hint. 

On-line Manual 

This manual is available on-line and can be viewed by selecting the Help 

menu item.  

Clicking on the Help button will open the help display.  
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C o l o r  a n d  I c o n  C o d i n g  

A color coding is used to show the alarm state of items on the system. 

Usually an icon is displayed on the left-hand side to symbolize the alarm 

state. The color coding is listed in the table below. 

 

Icon Text Color Meaning 

 
White Indicates an idle state. This means that the system 

is waiting for the first data to be received after 

starting. This can also mean there is a problem if 

an item remains white for a long period of time. 

 
Green Indicates an item is OK. The currently measured 

values are not outside any alarm or warning limits 

and any associated equipment has not failed.  

 

Yellow Indicates the item is in a warning state.  

 

Red Indicates the item is in an alarm state. Usually 

when a sample point enters an alarm state, it 

requires acknowledgement. The item will be shown 

in cyan until the alarm is acknowledged. The icon 

associated with the item changes to reflect the 

current alarm state of the item.  

 

D A R K  

B L U E  

Marks that an item has failed. Usually there will be 

some Notes to indicate the reason for the failure.  

U s i n g  t h e  C l i e n t  D i s p l a y  

The client display is divided into several parts: 

1. A menu bar at the top.  

2. A tool bar that offers most of the options of the menu. 

3. A tab control that shows each detected monitoring system. The tab 

headings show the current state of each node. 

4. Tables of sample points and alarm groups on the last selected node. 

The table cells are color coded to show the alarm state of the 

sample points. 

5. A list of units belonging to the currently selected node. The list is color 

coded to show the alarm state of the unit. 

6. A window display for a list of color-coded messages. 

 

The monitoring nodes can be selected and viewed by clicking on the 

appropriate tab. Please note: only one of these items can be viewed at any 

one time.  
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Menus 

Client  

 Menu Item Description 

 Login/Logout Quickly login in and logout of the client. 

 Client Options This item allows the local configuration for the client to be 

set up.  

 Change Password Allows the password of the current user to be changed. 

The new password must be more than five characters, it 

must also be the same in the New and Confirm password 

fields before it can be accepted. The current password is 

also required.  

 User Log Allows general comments to be made into the event log to 

record observations or comments.  

 E-mail Opens a simple e-mail client to send short e-mail 

messages to one of a restricted set of recipients. This is 

intended as an alternative to the user log entry function 

where users want to record general events or Notes. 

E-mailing is enabled in the local Options. 

 Refresh Updates the node list to reflect current connected nodes. 

Nodes are only removed from the list if they have been 

inactive for > 1 min. 

 Exit This menu option is only enabled for users with Exit 

privilege. When selected and confirmed, the client interface 

is closed. This may cause an operating system level logout 

or restart. 

Node 

 Menu Item Description 

 View View Status, Maps, and Graphs associated with each 

monitoring node.  

 Report Access all functions related to report, including generating, 

saving, and exporting reports. 

 Control Gives access to control monitoring nodes, including unit 

recipe, sample point recipe, and control of current node. 

 Configure Gives access to configure the last selected node. 

Windows 

 Menu Item Description 

 Units Display the status of the units associated with the currently 

selected node. 

 Statistics Displays all the statistics associated with sample, tag, 

alarm limits, SPC Status, and SPC limits. 

 Alarm Groups Displays the status of the alarm groups. 
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Help 

 Menu Item Description 

 Help Opens the on-line manual at the index page. 

 About FMS Displays the client software copyright, version, and build 

date information. 

Toolbar 

The toolbar options are similar to those given in the menu with the following 

additions. Where the icon on the toolbar is the same as in the menu, the 

function is the same.  

 
 

 Icon Icon Name Description 

 
 

Login/Logout Quickly login/out of Client. 

 

 
User Log Enter user log. 

 

 
E-mail Access e-mail functions. 

 

 
Client Options Configure client options. 

 
 

Refresh Refresh current status of the node. 

 
 

Report Set up and configure reports. 

 

 
Control Control each node. 

 

 
Configuration Configure each node. 

 

 
View Status View status view for each node. 

 

 
View Map View map view for each node. 

 

 
View Graph View graph view for each node. 

 

 
View AAS Status Show AAS status view for each node.. 

 
 

Output Control View Digital Output Control for each node. 

 
 

Batch Manager View Batch Manager for each node. 

 

 
View Units 

View current status of all units connected to the 

selected monitoring node. 

 

 
View Statistics View statistics of selected sample points. 
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 Icon Icon Name Description 

 

 
View Alarm Group View the alarm group status of current node. 

Sample Status View 

This pane shows all the sample points associated with the selected Node. 

This list is color coded to show the current alarm state of the sample points. 

The name, state, and current reading of each sample point are displayed.  

 

Message 

This pane displays the last 250 messages from all accessible nodes. The 

messages are color coded for the type of message. 

The Node column identifies the sample point node. Date/Time is the time 

stamp for the message. The Source column identifies the origin of the 

message—this can be a sample point, node, unit or some other item. The 

Type is the alarm state of the message. The Message field the 

message text.  

 

Status Bar 

The status bar shows the most recent message from the FMS software. 
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Logging into FMS 

Logging on to FMS requires a valid user account for the FMS system 

being used. 

 

Each user for a particular FMS system has privileges to perform various 

functions. Users can be assigned permission to change the configuration, 

other users can be allowed to acknowledge alarms or make reports.  

Password Aging 

If password aging is enabled and after the given number of days have 

elapsed, the user will be asked to change their password using the change 

password dialog.  

C o n f i g u r i n g  t h e  C l i e n t  

To configure a client system, a valid username and password for the FMS 

system in question must be used. To access the configuration facilities it is 

necessary to log onto the computer. Select Client -> Client Options or click 

the Client Options button  on the tool bar.  



 

FMS Client 4–7 

Identification 

 
 

 Client Name Title used as the caption of the user interface.  

 License Key License key issued. This controls the number of sample 

points that can be accessed. When a license expires, a 

reminder is displayed. If more than one client tries to use 

the same license key, these clients are disabled. License 

keys are FMS minor version specific. i.e., a license key 

that was generated for FMS 5.2.0 will only work with FMS 

5.2.x systems. License keys that were generated prior to 

FMS 5.2.0’s release are valid for all FMS 5.0.x versions 

and FMS 5.1.x.  

 Broadcast Port The port to be used for Client broadcasts.  

 Broadcast Using The network interface to be used for Client broadcasts.  

 Multicast IP 

Address 

The IP address to be used for multicast network.  

 Multicast Port The port to be used for multicast network.  
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Audit Logging 

This option configures the node that Audit log messages will be logged in 

and the text to be displayed as the source of audit log entries originating 

from the Client. If users are required to enter comments when changing 

configuration, the option exists in the Node security settings.  
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Modules 

This page selects which of the loadable extension modules are to be used 

by the client. This feature is used to enable or disable blocks of features.  
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FMS Components Information 

This page displays a printable table of the version numbers and builds dates 

of the components of the FMS software.  

 
(screen for reference only) 
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Remote Monitors 

This page allows the user to define remote monitoring tasks not on the local 

network that the Client is to connect to. The IP address and request port of 

the remote monitor must be specified.  
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Required Monitors 

This page allows the user to define monitoring tasks that are to be displayed 

by this Client. If a required monitor is not present, a failure condition will 

be triggered.  

If no required monitors are specified, all detected monitors will be displayed.  
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Display Monitor Messages 

The messages window will display messages from the Monitors that are 

checked in this window. By default, all Monitors are checked.  
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User Settings 

This page selects the Language option and the Date Format option. The 

Font Type and Size options can be selected for the main application and for 

the status tables.  
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Color Settings 

This page configures the colors associated with each state of the sample 

points. Alarm recovery messages are by default shown as Alarm 

notifications, select the option Show recovery messages as Ok to show 

these message types as OK in the Messages window. 
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Sound Settings 

This page configures the sounds played on a local computer when a node is 

not in an OK state. The sound played is that for the highest alarm state of all 

the detected monitoring systems. Select a sound to play and set the 

corresponding checkbox. Click the Play button on the far right of the 

filename to test a sound. Sounds are played about every 10 seconds. For 

this reason any sound should be less than 10 seconds in duration.  

 



 

FMS Client 4–17 

Auto Login Settings 

This page sets the auto login username and password for the Client and the 

preferred node to be displayed on startup.  
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Report Settings 

This page sets the scheduled report username. Scheduled reports will be 

generated according to the set schedule.  

This page also sets the location where generated reports will be saved. If 

Shared report location is checked, reports generated by all users will be 

saved in the folders specified in the Reports and Scheduled Reports fields. If 

not checked, reports will be saved for each user in the Users folder. 

Selecting the option Save in Year folder will result in reports being saved in 

sub-folders named according to the year the report is created in e.g., “2012”.  

 

In addition, this page also configures viewing a report in an external PDF 

viewer such as Adobe® Reader®.  

The “Locate Adobe Reader” button will attempt to automatically locate the 

installed Adobe Reader software.  
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If the “Locate Adobe Reader” fails to find Adobe® Reader®, or you want to 

use a different program, select the “…” button which will open a file browser, 

and browse to the executable file of the program that you want to open 

PDF reports. 

 

After selecting Open, the text field will automatically populate with the 

selected file path. 
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Map Settings  

This page sets the map options that will be used for the map display for 

this Client.  
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Status Settings  

It is possible to configure Status Settings so warning messages are not 

displayed in the Status Bar.  
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E-mail Settings 

It is possible to configure E-mail Outputs such that an e-mail is sent when an 

alarm group enters a particular state, for example if it starts alarming.  

 

This page sets the e-mail SMTP server, the e-mail address of sender, and 

the list of e-mail recipients. The E-mail Output configuration options are 

as follows:  

 

 E-mail Option Description 

 SMTP Server Name Address of the server which will handle the e-mail. 

 Default Port Use the default port for the SMTP Server. 

 SMTP Port The port to use for the SMTP Server. 

 Authentication Enable authentication for e-mail. 

 User Name The user name to use to authenticate the e-mail. 

 Password The user password to use to authenticate the e-mail. 

 Sender’s E-mail 

Address 

Originator's e-mail address used to identify where the 

e-mail came from. 

 SSL/TLS Enable SSL/TLS.. 

 Recipient E-mail 

Address Book 

Permitted e-mail addresses to which e-mail alerts can 

be sent. 
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C H A P T E R  5  
Us ing FMS Cl ient   

FMS 5 allows software installation in standard mode. In this mode, the client 

will be very flexible. Multiple status, graph, and report windows can be 

created. Multiple map windows to monitor the status of sample points can 

also be created. FMS software also allows current settings to be saved and 

loaded later. Use File -> New or click the  button to create a new window 

after the FMS software starts.  

 

 

 N O T I C E  

This option is not available in Pharma mode. 
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C r e a t e  S t a t u s  W i n d o w  

To create a new Status window, use File -> New or click on the  button.  

 

Select Status from the Window Type list then select the node for which the 

status will be displayed. Click Next.  

 

 



 

Using FMS Client 5–3 

In Table format, status will be displayed as table shown below. Alarm groups 

can be included in Table format.  

 

In List format, status will be displayed as list shown below. The list can be 

sorted by data types. Alarm groups cannot be included in List format.  

 
 



5–4 FMS Software User’s Manual 

 

Then the sample points to be shown on the Status window should be 

selected. Click Next to go to the next step.  

 

 

An optional “Additional Title Text” can be added to identify each Status 

Window. Multiple Status windows can be created and displayed at the 

same time.  



 

Using FMS Client 5–5 

C r e a t e  U n i t s  W i n d o w  

To create a new Units window, use File -> New or click on the  button.  

 

Select Units from the Window Type list then select the node for which the 

units will be displayed. Click Next.  

 

An optional “Additional Title Text” can be added to identify each Units 

Window. Multiple Units windows can be created and displayed at the 

same time.  
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C r e a t e  G r a p h  W i n d o w  

To create a new Graph window, use File -> New or click on the  button.  

 

Select Graph from the Window Type list then select the node for which the 

graph will be displayed. Click Next.  
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Now the sample points to be shown on the Graph window should be 

selected. Click Next to go to the next step.  

 

Graph options allow selection of the start and end time for graph display. It 

also allows configuring the graph as dynamic or using log scales, static or 

dynamic rolling graph. A dynamic rolling graph will maintain the previous 

amount of specified time on the graph. For example, a 1-hour dynamic 

rolling graph will maintain the previous 1 hour of data on the graph relative to 

the current time.  
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A graph can also be initially created with certain channels and limit lines 

enabled or disabled. By default all channels and limit lines are enabled. If a 

channel is disabled, all associated limit lines will automatically be disabled 

as well.  

 

An optional “Additional Title Text” can be entered to help identify the 

graph display.  
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C r e a t e  M e s s a g e  W i n d o w  

To create a new Message window, use File -> New or click on the  

button. It is only possible to open one Message window at any time.  

 

Select Messages from the Window Type list. Click Next.  

 

An optional “Additional Title Text” can be added to identify the 

Messages Window.  
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C r e a t e  M a p  W i n d o w  

To create a new Map window, use File -> New or click on the  button.  

 

Select Map from the Window Type list then select the node for which the 

map will be displayed. Click Next.  

 

An optional “Additional Title Text” can be added to identify each Map 

window. Multiple Map windows can be created and displayed at the 

same time.  
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C r e a t e  R e p o r t  W i n d o w  

To create a new Report window, use File -> New or click on the  button.  

 

Select Report from the Window Type list then select the node for which the 

report will be displayed. Click Next.  

 

An optional “Additional Title Text” can be added to identify each Report 

window. Multiple Report windows can be created and displayed at the 

same time.  
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C r e a t e  C o n f i g u r e  W i n d o w  

To create a new Configure window, use File -> New or click on the  

button. It is only possible to open one Configure window at any time.  

 

Select Configure from the Window Type list then select the node for which 

the configuration will be displayed. Click Next.  

 

An optional “Additional Title Text” can be added to identify the 

Configure Window.  
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C r e a t e  C o n t r o l  W i n d o w  

To create a new Control window, use File -> New or click on the  button.  

 

Select Control from the Window Type list then select the node for which the 

controls will be displayed. Click Next.  

 

An optional “Additional Title Text” can be added to identify the 

Control window.  
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C r e a t e  O u t p u t  C o n t r o l  W i n d o w  

To create a new Output Control window, use File -> New or click on the 

 button.  

 

Select Output Control from the Window Type list then select the node for 

which the output controls will be displayed. Click Next.  

  

An optional “Additional Title Text” can be added to identify the Output 

Control window.  
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C r e a t e  B a t c h  M a n a g e r  W i n d o w  

To create a new Batch Manager window, use File -> New or click on the 

 button.  

 

Select Batch Manager from the Window Type list then select the node for 

which the output controls will be displayed. Click Next.  

 
 

An optional “Additional Title Text” can be added to identify the 

Control window.  
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C H A P T E R  6  
Conf igure  and  
V iew Moni tor ing  Node 

To configure a monitoring system the user must have a valid username and 

password for the node in question and have permission to configure that 

node. To access the configuration facilities it is necessary to log into the 

node and select the Node -> Configure menu option.  

C o n f i g u r e  N o d e  

Only users with appropriate permissions can configure the FMS system for 

the node to be configured. It is possible for different clients to try and edit a 

given monitoring system's node at the same time. For this reason, it is 

preferable to have only one user with configure permission per 

monitoring system.  

 

To configure a particular monitoring system, select the monitoring system in 

the node tab and select Node -> Configure from the menu; or select the 

node in the node tab and click on the  button on the tool bar.  

Monitor Details Page 

This page displays the current settings of the monitor. The current 

configuration can be exported to a file.  
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Monitor Summary -> Configure Devices 

This page displays the current configured units, sample points and 

digital outputs.  

 

Monitor Summary -> Configure Devices -> 
AeroTrak+ Devices 

This page manages the AeroTrak™+ device configurations. If configuring an 

AeroTrak™+ Remote Particle Counter please follow technical note TCC-165. 

If configuring an AeroTrak™+ Active Air Sampler please follow technical 

note TCC-187.  
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Monitor Summary -> Configure Devices -> 
Communication 

FMS uses Communication Channels to communicate with equipment. 

There are two types of communication channel Ethernet using TCP/IP 

and serial port.  

 

This page displays the current configured communication interfaces. An 

existing communication interface can be configured or create a new 

communication interface. To configure an existing interface, right mouse 

click on the selected communication and select Properties from the 

pop-up menu.  
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To create a new communication, right mouse click on the blank area, select 

New Communication Channel from the pop-up menu.  

 
 

 Field Description 

 Name Free text description of the channel. 

 Packet Driver Enables selection of the preferred packet driver mode.  

Ethernet Communications 

In the case of Ethernet serial ports the port configuration is done using a 

Web Browser or Telnet interface. Ethernet devices have the advantage in 

that they can be independent of the computer the monitoring task is running.  

 Field Description 

 IP Address IP address of the unit. This will often be a fixed IP address 

but can be a host name (e.g., serial factory) if DHCP is 

used to set up network addresses.  

IMPORTANT NOTICE 

DO NOT use any leading zeroes in the IP Address 

as this will not work with FMS, i.e., DO NOT use 

192.168.044.56, instead use 192.168.44.56. 

 

 Port Number TCP port to connect to. Refer to the Ethernet device's 

documentation for full details.  
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Serial Communications 

This sets up the serial ports for the computer on which the monitoring 

system is running.  

 
 

 Item Description 

 Name Selects the serial port to use.  

 Packet Driver Enables selection of the preferred packet driver mode.  

 Baud Rate Selects the speed at which the interface is to run. 

 Data Number of data bits in the serial byte. Usually this is 8.  

 Stop Number of stop bits. This is usually 1.  

 Parity Selects the parity bit. This is usually None.  

 Flow Control Selects the type of flow control used for controlling data 

transmission. Usually this is None, but can be Hardware 

(for RTS/CTS/DTR) or Xon/Xoff.  
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Monitor Summary -> Configure Devices -> Units 

This page displays the current configured Units.  An existing Unit can be 

configured or a new Unit created. To configure an existing Unit, right mouse 

click on the selected Unit and select Properties from the pop-up menu.  

 
 

To create a new Unit, right mouse click on the blank area, select New Unit 

from the pop-up menu.  
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Monitor Summary -> Configure Devices -> 
Digital Outputs 

A Digital Output is an abstraction of an output from a unit that can be on or 

off. Relay outputs, that in turn control alarm beacons, is a common example.  

 

This page displays the current configured digital output. An existing Digital 

Output can be configured or a new Digital Output created. To configure an 

existing Digital Output, right mouse click on the selected Digital Output, and 

select Properties from the pop-up menu.  

To create a new 

digital output, right 

mouse click on the 

blank area, select 

New Digital Output 

from the pop-up 

menu.  

The Digital Output 

forms allow 

mapping an alarm 

group to a selected 

unit's digital output. 

The device driver 

for the unit supplies 

the list of possible 

digital outputs.  
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The recipe independent part of the digital output configuration has the 

following fields:  

 

 Field Description 

 Alarm Group Selects the alarm group that controls the digital output.  

 Alarm State Sets the test used to determine if a digital output is on or 

off. An output is on if the expression is true; otherwise, it is 

off. The first field is a comparison operator (<,>, =, <>), the 

second field is the alarm level to compare against. The 

resulting expression, <alarmgroup state> <comparison 

operator > <alarm level> is evaluated every time the 

alarm group is updated, and the digital output updated 

according to the result.  

 Allow Control and 

Scheduling 

When set the digital output can be controlled and 

scheduled from the Client.  

 Enabled When set the output is active and the output follows the 

configured relationship with the alarm group. If not, it 

remains at the default state.  

 Retrigger When set the Digital Output will force the output to refresh 

even if no changes have occurred. This is useful where 

manual silencing of alarms may be used.  

Monitor Summary -> Configure Devices -> 
Sample Points 

Sample Points represent measured values from units.  

 

This page displays the current configured Sample Points. An existing 

Sample Point can be configured or a new Sample Point created. To 

configure an existing Sample Point, right mouse click on the selected 

Sample Point and select Properties from the pop-up menu.  
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 Field Description 

 Sample Point Name Free text description of the sample point.  

 Unit Unit associated with the sample point.  

 Data Type Identifies the class of measurement. Units can often 

measure several types of data; for example, particle 

counts, environmental parameters, and instrument status.  

 Display Units Free text field that allows the physical units to be set for 

display purposes.  

 Input Index Selects the channel of a particular sample point type that 

is mapped to the sample point. Only the available input 

indices are given as choices.  

 Decimal Places Selects decimal places for displaying the sample points.  

 Recipe The recipe for which sample point properties are 

displayed.  

 Comments Free text that will be displayed with the sample point name 

in reports and Inspect windows.  

 Additional 

Comments 

Free text that will be displayed with the sample point name 

in reports.  

 Use Log Graph 

Scales 

When set, graphical displays will use log scales when 

displaying any data from this sample point. Usually this is 

set when the data is from particle counters where the 

range of values is very large.  

 Calculate MKT Select if the option to calculate mean kinetic temperature 

for reports, is required for a sample point.  
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The SPC tab specifies the SPC alarm limits and the control limits. The Alarm 

limit and Mean Crowding limit only have effect if valid control limits are 

defined. SPC alarms are not always appropriate.  

 

The Recipe tab allows selection of the Preferred Tag which is a hint for 

some displays to show values for this tag before others.  
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 Field Description 

 Enabled When checked, the sample point is enabled and data 

collected for the sample point is updated and processed. If 

a sample point is not enabled, data will still be collected for 

it, but not updated or processed.  

 Fileable When checked, the collected data is stored in the 

database, providing the sample point is also enabled. 

This is usually checked. However, there are cases 

where measured data is only for information or 

diagnostic purposes and not required as a part of any 

permanent record.  

 Re-triggerable 

Alarms 

When checked, an alarm event is generated for each 

measurement that is in alarm. When it is clear, an alarm 

event is generated only when a sample point enters an 

alarm state. This affects the setting of the acknowledgment 

required flag. If this flag is set, the acknowledgment 

required flag gets set with each value in an alarm state.  

 Hide When checked, the sample point will not be displayed in 

Status displays.  

 Disable 

Acknowledge 

When checked, the alarm start will not be 

acknowledgeable.  

 Alarm Threshold Number of consecutive values that are outside the 

alarm limits that must be measured before the sample 

point goes in to alarm. Until the alarm threshold is 

reached, the sample point is put into a warning state. 

This feature is useful for measurements which can have 

brief periods of being in alarm in normal use (such as 

differential pressure sensors) and so these nuisance 

alarms can be suppressed.  

 Sample Period Sets the sample period in number of seconds. This field is 

only enabled when relevant.  

 Preferred Tag Sets the preferred tag for the sample point.  

 Enable Buffer 

Download 

When checked, FMS will perform buffer download as 

needed for the unit related to the sample points. Buffer 

size will define data points read from unit buffer.  
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 Field Description 

 Alarm Limits Table of alarm and warning thresholds for each of the 

possible sample point values tags. To enable a warning or 

alarm threshold, set the check to the right of the limit and 

then enter the threshold value.  

 

The Driver tab allows selection of options that are specific to the type of Unit 

for the sample point.  

The Driver Recipe tab allows selection of options that are specific to the 

type of Unit for the sample point and that can vary dependent on which 

Recipe is in use.  
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Monitor Summary -> Configure Devices -> 
Alarm Groups 

Alarm groups are collections of sample points and other alarm groups. The 

alarm state of an alarm group is the highest alarm state of any of the 

members. Alarm groups are useful for managing alarm enunciation and 

controlling events.  

 

This dialog displays the current set alarm groups. An existing alarm group 

can be configured or create a new alarm group. To configure an existing 

alarm, right mouse click on the selected alarm, and then select the 

properties option from the pop-up menu.  
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Use this screen to choose to enable or disable an alarm group. To create a 

new alarm group, right mouse click on the blank area and then select 

New Alarm Group from the pop-up menu.  

Alarm Groups have the following recipe independent parts:  

 

 Part Description 

 Comments A free text description of the alarm group that appears in 

the alarm group display. 

 Sample Point List Lists all sample points for the monitoring node. To include 

a sample point in the alarm group set the checkbox next to 

it. To remove a sample point from the alarm group clear 

the checkbox. Any one sample point can belong to any 

number of alarm groups. 

 Alarm Group List A list of all alarm groups at the monitoring node. To 

include another alarm group in an alarm group, set the 

check next to it. To remove the alarm group, clear the 

check next to it. An alarm group can belong to any 

number of other alarm groups on the same node. It 

should be noted that cyclic dependencies (where an 

include alarm group depends on the alarm group that it is 

being included in) are not detected and although this will 

not cause any failures, the alarm group will remain at the 

highest alarm state. 

 Message Type List of messages associated with the driver type of the 

selected Sample Point.  

 Enable 

Acknowledge 

Require acknowledgement of the corresponding 

driver message.  

 Enable This checkbox is recipe dependent. So it is possible to 

have alarm groups active only when certain recipes are 

enabled globally. 

 Visible When this checkbox is set, the alarm group will appear on 

the Alarm Group Status display. This is a hint to other 

modules that the alarm group can be displayed. 
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Monitor Summary -> Configure Devices -> Recipes 

This page displays the current configured Recipes. An existing Recipe can 

be configured or a new Recipe created. To configure an existing Recipe, 

right mouse click on the selected Unit and select Properties from the 

pop-up menu.  

  

Monitor Summary -> Configure Devices -> Actions  

An Action is a task that is triggered by either a timed event or a change of 

sample point state.  
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This page displays the current configured Actions. An existing Action can be 

configured or a new action created. To configure an existing Action, right 

mouse click on the selected Action and select Properties from the 

pop-up menu.  

 

State Trigger Action 
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Timed Trigger Action 

 Field Description 

 Name The name of the action.  

 Sample points 

(State trigger only) 

The Sample Points that can trigger the action.  

 Trigger  

(State trigger only) 

The sample point event that will trigger the action. Options 

are Alarm or (value) Update.  

 Scheduled time 

(Timed trigger only) 

The time at which the action is to be executed.  

 Notes Free text field for configuration notes.  

Log when triggered  When checked, the action will be logged in the event log 

when triggered.  

Enabled 
When checked the Action is enabled and can be triggered.  

Action The command to be run when the action is triggered, e.g., 

notepad.exe "C:\FMS5\Actions\Alarm.bat". 

Substitute values When checked fields in the Action will be replaced by 

actual values when the Action is triggered.  

? Select to see a table of options available for command 

line substitution.  

 

  

Action command line substitution options 
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Monitor Summary-> Configure Devices -> 
System Settings 

This page allows setting general system settings.  

  
 

 Field Description 

 Reset at Midnight When selected the statistics displayed in statistics 

windows will be zeroed at midnight.  

 Acknowledgement 

Reasons 

Enter a set of standard reasons that can be selected when 

acknowledging alarms.  
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Monitor Settings 

This page allows setting general settings related to the monitor.  

 
 

 Field Description 

 Monitor 

Identification 

Allows entering the name of the monitor node and the 

license key associated with the monitor node. 

 Monitor Language 

Settings 

Allows configuring the language option of the monitor and 

text read orientation of the monitor.  

 Monitor Traffic 

Settings 

Sets the port number to be used by the client and 

monitoring systems to broadcast messages to all other 

monitoring systems and clients. This must be the same for 

all members of a networked monitoring system; otherwise, 

not all members of the monitoring network will be detected. 

It is possible to have more than one network of monitoring 

systems sharing the same LAN, using different broadcast 

addresses to operate completely separate from one 

another. Where no hardware supporting UDP broadcasts 

are available, both the client and monitoring system must 

be started with the local flag.  

 General Allows setting a scheduled reboot time for the monitor and 

SQL archive option.  
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Buddy Settings 

This page is used to set up a buddy system. A monitor can “watch” up to 

three monitoring nodes and start a buddy monitor in case of failure of any of 

the watched nodes. For each monitor that is being watched, the command 

line to be used to start the buddy when a monitor fails must be specified.  

 

The Buddy Behavior field Take Over After must be populated only for the 

watching monitor to monitor how long a watched node must be inactive 

before the buddy command line is executed.  

 

The Buddy Behavior field Exit if Node Active must be populated only for the 

buddy to specify the conditions that will cause it to exit. It must not be 

populated for the watching monitor.  
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Database 

This page sets database configurations.  

 

 

 Field Description 

 Database Type Sets the type of database used by the monitor.  

 Server Address 

and Port 

Sets the server address and port for the database.  

 Database Name Sets the name of the database used by the monitor. 

 Test Connection Allows testing database connection based on current settings.  

 Client User and 

Password 

Sets the Client username and password for database access. 

Users must have read and write permissions.  

 Node User and 

Password 

Sets the node username and password for database access. 

Users must have read, write, and create permissions.  

Mirror Database 

This page sets the mirror database setting for the monitor node.  
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Reporting Settings 

This page sets the report setting for the monitor node.  

This page is used to determine whether all users share the same set of 

report templates or if each user has access only to the reports that the user 

has configured.  

 
 

 Field Description 

Shared report 

templates 

Select this option if all users are to share report templates.  

Location  The location on the monitoring computer where the report 

templates are to be held.  

Use unique ID Select if a unique 6 digit ID is to be displayed in the report 

footer for each generated report. IDs are sequential.  

ID prefix Specify a prefix to precede the ID if required.  
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OPC UA Settings 

This page is used to change OPC UA Server settings.  Please follow 

technical note, TCC-156 for configuring the OPC UA Server in FMS. 

 

Security Page 

This page sets the security related options. 
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 Field Description 

 Enable As 

Password Server 

Enables the monitor to be the password server. 

 Comments required 

for changes 

When checked, comments are required to be entered 

when changes are made to the configuration. 

 Maximum Idle Time Client will automatically log the user out of the client 

application when no keyboard or mouse activity has been 

detected for the given number of minutes.  

 Password Duration When checked, all passwords are required to be 

changed if they are older than the given number of days. 

This is a useful security feature as it prevents discovered 

passwords being used for too long. This also sets if the 

last password is allowed.  

 Failed User logins 

allowed 

Sets maximum attempts for user login. The Client 

will be locked after the maximum failed attempts 

have been reached.  

NOTICE 

If Failed Client logins allowed is enabled, failed User logins 

allowed must be less than failed Client logins allowed.  

 Failed Client logins 

allowed 

Sets maximum attempts for Client login. The Client 

will be locked after the maximum failed attempts have 

been reached.  

NOTICE 

If Failed User logins allowed is enabled, failed Client logins 

allowed must be greater than failed User logins allowed.  

 Unlock Client  Becomes enabled if a user attempts to login and fails for 

the given number of times causing the client interface to 

lock. The system administrator is required to unlock it. 
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User Group 

This page displays the current configured User Groups. The table contains 

an overview of each User Group’s parent category. The User Group will 

have full privilege if the column displays “Yes” and no privilege if the column 

displays “No”. If the column displays “Partial”, check the User Group’s 

properties to see which sub-categories the User Group has access to. 

 

An existing User Group can be configured or a new User Group created. To 

configure an existing User Group, right mouse click on the selected User 

Group and select Properties from the pop-up menu. To create a new User 

Group, right mouse click on the blank area and select New User Group from 

the pop-up menu.  

 



6–26 FMS Software User’s Manual 

User Privileges 

This is the initial window 

when configuring a User 

Group, the list of categories 

are the parent categories. A 

check indicates the User 

Group has full privileges to 

the parent category and all 

sub-categories, no check 

indicates the User Group 

has no privilege to the 

parent or any sub-category. 

If the check box is partially 

checked (Reports in the 

graph) means at least one 

but not all sub-categories 

are checked. 

 

When the mouse is hovered over a category, the text will be bolded and font 

size slightly increased if the category has a sub-category. Click the text to 

display the sub-category. This applies to parent categories as well as 

sub-categories (some sub-categories have sub-categories). 
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Before any actions are taken, FMS will request a username and password 

and will check if the user is allowed to perform the action before proceeding. 
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This page displays the 

current configured 

Users. An existing User 

can be configured or a 

new User created.  

 

To configure an existing 

User, right mouse click 

on the selected User and 

select Properties from 

the pop-up menu.  

 

To create a new User, right 

mouse click on the blank 

area and select New User 

from the pop-up menu. 
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V i e w i n g  a  M o n i t o r i n g  N o d e   

To view a particular monitoring system, select the node in the tab controls. 

The software will display all the samples points, alarm group, and statistics 

associated with the node. View -> Status, Map, Graph and AAS Status can 

also be selected.  
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View Status 

 
 

 

Inspect 

This opens an inspection window. An 

inspection window is a real-time display of the 

current status of a sample point, plus a 

graphical and tabular display of historic data. 

The table and graph are updated as new 

values are collected. 

 

Inspection windows displays the selected 

amount of data. As new data is received, the 

oldest data is discarded. 

 

If the Ack option is enabled for the current user, any alarms for the selected 

sample point can be acknowledged as described in the following sections. 

If the Data Entry option is enabled for the current user, data can be 

manually inserted for the selected sample point by selecting Input. 
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Sample Point Inspection Windows 
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 Item Description 

 Print Table Visible part of the table is printed.  

 Print Graph Graph is printed.  

 Print Current Statistics Current sample point statistics are printed.  

 Close Inspection window is closed.  

Alarm Group Inspection Windows 

The Status and 

Floor Plan 

displays allow 

alarm groups to 

be included. 

Clicking on an 

alarm group item 

opens an Alarm 

Group Inspection 

window. This 

lists the 

members of the 

alarm group.  

Clicking on an alarm group member makes that sample point the current 

sample point. Clicking on a sample point, then pressing the inspect button 

opens the inspect menu (described elsewhere). 

The alarm group inspection window is closed by clicking on the close button. 
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Manual Data Entry 

The Manual Data Entry 

feature allows entering 

data to the database 

with a timestamp. The 

Manual data entry 

dialog is available by 

right-clicking on a 

sample point in the 

node status page. User 

verification is required 

before the data is 

added to the database,  
 

and only users who have appropriate permissions will have access to 

this functionality. 

Data entered in this way will be commented to indicate the source of the 

data as illustrated below. 

 

Acknowledge Alarms  

The order of the alarms listed can be changed by clicking on the header of 

any column.  
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The alarm list dialog allows the following options:  

 

 Icon Option Name Description 

 

 

Ack. Selected Alarms can be selected for acknowledgement by 

clicking on the corresponding row number to the 

left of the table. 

 
 

Ack. All for 

Sample Point 

All alarms in the list are acknowledged.  

 
 

Ack. All Pending All pending alarms for the selected node are 

acknowledged.  

When acknowledging alarms the following dialog is displayed: 

 
 

 Field Description 

 Reason Allows a free text entry in the alarm log to be made to explain the 

alarm event.  

Preconfigured reasons can be selected if these have been entered 

in System Settings in the configuration. 

 User Name of the user that acknowledges the alarm. 

 Password Password for the user. 
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View Statistics 

Most display windows show sample 

points. Left-clicking on a sample 

point causes the Sample Point 

Status display to show the current 

values for that sample point. Right-

clicking on a sample point shows the 

inspect menu described previously 

plus an option to acknowledge any 

alarms also as described in a 

previous section. 

 

Sample Point Statistics 

The Sample Point Statistics pane shows the current status of the last 

selected sample point, the current values, and alarm limits of that sample 

point.   

The SPC status panes show three common SPC statistics as shown in the 

table below.  

 

 SPC Statistic Description 

 Mean Crowding Number of consecutive readings that are between the 

upper and lower control limits. 

 Alarm Number Number of consecutive readings that lie outside the 

control limits.  

 Trend Number Number of consecutive readings that are increasing 

or decreasing.  

These statistics can be used to predict alarm states before they arise. An 

understanding of the process being monitored is necessary to know if SPC 

alarms are useful.  

This shows the configurable items. Clicking on an item displays the 

associated configuration form on the right. Double-clicking on an item will 

show any minor items. Double-clicking again will hide any minor items. As an 

item is selected, the data for the item is displayed in the configuration form. 
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M a p  

The Floor Plan display can display a room/building layout designed by using 

a layout designed with the Map Editor and an optional background bitmap. 

 

The maps and backgrounds are downloaded from the monitoring node as 

needed. The default map for a monitoring node must have the same name 

as the monitoring node e.g., Node1.xml for the node Node1. 

These maps and backgrounds must be placed in the FMS Maps directory on 

the monitoring node's system. 

A background bitmap can be included too. These backgrounds must be 

JPEG files (ending with .jpg). The naming rules are the same as the floor 

plan design files. 

A background bitmap should be added to the FMS maps directory. This 

background must be a JPEG file (ending with .jpg). If additional maps are 

required, the bitmaps should be added to the FMS maps directory and 

should be named as the user’s preference. 

When a map is edited and saved, an Xml file for the map configuration will 

be created in the FMS maps directory. 
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Active Icons 

Icons can be static or animated. All active icons have the extension .pix. A 

pix file is one or more XPM files. All icons must be in the Maps directory to 

be recognized.  

 

Sample point names can be displayed instead of icons if the option is 

selected in Client Options – Map Settings or is configured on the map 

when the map is set up. 

 

Map Viewer 

 
 

When selecting the Map option, the icons above are added to the main 

tool bar.  

If a map has already been configured for the node, the map will be displayed 

with the configured settings. Otherwise, a blank screen will be displayed and 

the New Map option allows a map to be created.  

 Icon Icon Name Description 

 
 

Zoom In Zoom in to the map, each click makes the 

map larger. 

 
 

Zoom Out Zoom out of the map, each click makes the 

map smaller. 

The map will never go smaller than the original size 

(users can only zoom out the same number of times 

as zoom in). 

 
 

Print Map Current map display is printed.  

 
 

Edit Map Provides Map Editing functionality. 

 
 

New Map Create a new map. 
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Map Editor (Plan Editor)  

 

The Map Editor allows the editing of simple 2-D layouts. The tool bar along 

the top of the displays provides the functions described in the table below.  

 Icon Icon Name Description 

 
 

Open Map Existing map display can be selected and 

loaded. The background bitmap is also 

loaded. 

 
 

Save Map Current map display is saved under the given 

name. When starting, the user interface loads 

the map named <node name>.xml.  

 
 

Clear Map Clears the current map configuration. 

 
 

Map Text Options Selects the text, foreground color and font for 

text labels.  

 
 

Change Background Allows changing the image file being used for 

the background. 

 
 

Exit Edit Exits Edit mode and prompts to save changes. 

 

Right mouse click on the map to add monitoring functions onto the map. 

 Function Description 

 Add Active Icon Adds an active icon at the selected position. The active 

icon dialog is displayed to set the object's configuration.  

 

 

 Field Description 

 Sample Point Sets the name of the sample point to be associated with 

the icon displayed on the map.  

 Tag Sets which value is to be displayed under the icon on 

the map. 

 Icon Selects the icon to use to represent the sample point on 

the map. Icons can be static, animated, or dynamic. When 

set to (none) the sample point name is displayed. 

 Action Selects the action to perform when the active object is 

clicked. When set to (none), no action is run.  
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 Function Description 

 Add Alarm Group Adds an alarm group to the map. The alarm group 

selection dialog is displayed to allow the selection of the 

alarm group and the icon to use.  

 

 Add Digital Output Adds digital outputs to the map. The digital output 

selection dialog is displayed to allow the selection of the 

digital output and the icon to use. If Toggleable option 

is selected, the digital output can be switched by 

clicking the icon on the map, provided the user has the 

appropriate permissions.  

 

 Add Link Creates a map link from one map to another. This is used 

to provide maps with greater detail.  

 

 Add Icon Adds an inactive icon to the map display. The selected 

icon is displayed. Only images in the Maps/Icons directory 

are selectable.  

 

Move Objects 

Objects can be moved by clicking on them and then dragging the object to 

the required position. 
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Edit Objects 

Active Objects can be edited by right mouse clicking on the icon on the map 

and selecting the Edit menu option. 

Delete Objects 

To delete an object, right mouse click on the object. Active objects are 

deleted by first right-clicking then selecting the Delete menu option. 

Select Text Options 

To select color, click on  

Map Text Options icon. The 

Text Options dialog is 

displayed. Select a color and 

font and click OK. Any text that 

is added from now on will use 

the selected color. 

 

To change the color of a 

selected text, select the text 

and then click on the map text 

color icon. The Text Options 

dialog is displayed. 

 

Click OK to accept, Cancel 

to reject. 
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Select Active Objects 

To select an active 

object, right mouse click 

on object and then 

select Edit from the 

pop-up menu. 

 

This allows an active 

object to be configured. 

 
 

 Field Description 

 Sample Point Sets the name of the sample point associated with the icon 

displayed on the map.  

 Tag Sets which value is to be displayed under the icon on the 

map when in user mode.  

 Icon Selects the icon to use to represent the sample point on 

the map. Icons can be static, animated or dynamic.   

 Action Selects the action to perform when the active object is 

clicked. When set to (none), no action is run.  

Click OK to save the changes, click Cancel to discard the changes.  

Clear Map Items 

To clear all items from map, click on  Clear Map icon. All icons will be 

cleared and only the background bitmap will be left. 
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G r a p h  

 

Quick Zoom 

Select Zoom to open a quick zoom menu where the option to enable zoom 

as well as reverting the graph to its default zoom is available. Reverting a 

graph to its default zoom will not disable zoom.  
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Quick Enable/Disable Lines 

On the main graph window, you can left-click an entry in the legend to 

enable or disable the line. 

 
 

Mouse hovering over a line will fade out all other lines and highlight the 

corresponding y-axis in the line color. 
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A [#] is at the end of every entry in the legend and its corresponding [#] is at 

the end of its y-axis label. 

 
 

 Icon Description 

 

 

 

 Create a new graph. 

 Open a graph. 

 Tile Graph Windows. 

 
Cascade Graph Windows. 
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Create a Graph 

Graph options allows selecting the start and end time for graph display. The 

graph can be configured as dynamic and/or log scales can be used.  
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Configure an Existing Graph 

Common Tab  

  
 

 Option Description 

 Chart Title Sets the title of the graph window. 

 Theme Selects the theme of the graph window. 
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Special Sample Point selections have the effects shown in the table below.  

 

 Option Description 

 Disable, Enable 

Zoom, Edit 

Annotations 

Select one of three graph states: 

 Enable 

Zoom 

Zoom in a graph by left hold click, drag the 

mouse to create a zoom box and release 

left mouse. Right-click to zoom out. By 

checking restore default zoom, the chart 

will revert to its range specified in the 

Axis tab. 

 Edit 

Annotations 

Mouse hover over a dataset line to create 

an annotation window. Click to drop the 

annotation on the graph, a new window 

will appear to enter in a note. The note 

can accept multiple lines of text by hitting 

the Enter key. Once an annotation is 

placed on the graph, left hold clicking on 

the annotation will allow you to re-position 

the annotation box. Note that the point of 

the annotation will still point to the same 

location. Right-click on an existing 

annotation to edit the text or delete the 

annotation from the graph.  

NOTICE 

Edit annotations is intended to be used 

with static graphs. 

 Show Serial 

Numbers 

A special case of annotation used only for 

those sample points with the serial 

number of the instrument.  

 Disable Neither zoom nor edit annotations is 

allowed. In this state a left click will display 

a box indicating the x and y axis values of 

the mouse position. 

 Legend Position Place the legend on the top, left, bottom, or right of 

the graph. 

 Detach Legend and 

Resize/Reposition 

Contents 

Enabling this feature will detach the legend from the graph. 

A detached legend can be resized and repositioned on the 

graph as well as scaling and translating the graph itself. 

Disabling this feature will revert the graph to its default 

scaling and position and re-attach the legend to the graph. 

 Legend Font Size Specifies the legend font size. 

 Make Data Points 

Visible 

Specifies if data markers will be drawn for each data point. 
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Line Options 

Line Options allows specifying the line width, selecting the color of each data 

line, and specifying if the line should be displayed or hidden on the graph. 
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Axes 

Axes allow specifying the min and max of the axis. The graph can auto scale 

if Auto option is selected. Specifying the tick count will change the amount of 

labels on a given axis. An axis can be in linear or logarithmic base 10 scale. 

Switching the scaling of an axis will switch the scaling for all associated plot 

lines. Tick count is disabled with log scaling. 
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Limit Lines 

Limit Lines allows adding alarm limit lines and setting the line color.  
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Control Charts 

Control Charts allow configuration of control charts. A control chart can only 

be created if the graph only has one sample point.  

 



6–52 FMS Software User’s Manual 

R e p o r t s  

The reporting functions are accessed from the View Node display. FMS can 

generate simple, functional reports from the results stored in the databases. 

The report designs are by default stored on the monitoring system on a per 

user basis, but the report pdf files are stored on a per user basis on the 

computer from which the request was issued. If a file Logo_report.jpg is 

included in the FMS5\Config folder, it will be used in the header of 

generated reports.  

 

The Reports screen allows creating, viewing, printing, modifying, exporting, 

and deleting a report. It consists of:  

• A Reports list window displaying all of the reports configured for the 

current user.  

• A scheduled Reports list window displaying all of the scheduled reports 

configured for the current user.  

• A Reports description window that displays a description of the currently 

selected report.  
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New Report/Modify Selected Report 

 
 

 Option Description 

 Report Name Define the name of the report. 

 Report Title Title of the report. 

 Report Type The options are:  

 Normal Report  Select the date and time for the report time span.  

 Batch Report  If Batch Manager is in use, it is possible to set up 

reports using batch names and events to define 

the start and end time of reports.  

 Month Report  Select the start month and the report time span 

as whole or parts of months.  

 Daily Report  Select the day the report time is to span.  

 External Report  Allows a command line to be entered to run an 

external report generator.  
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 Option Description 

 Report Data Select what data is recorded in the report tables. Report data can be 

one of these:  

 No Sample Point Data  

 All Sample Point Data  

 Alarms and Warnings Only alarm and warning events. 

 Only Alarms Only alarm events. 

 Alarm Summary Only alarm start and 

acknowledgement events. 

 Alarm Summary with Plots A plot for each sample point with alarm 

limits shown together with a table of 

alarm start events. 

 AAS Program Data A table for each AAS sample point and 

plate ID. For detail on the use of this 

report selection please follow technical 

note TCC-187. 
 Other options are: 

 Stats Include statistics tables. 

 Stats Summary Include a single statistics summary 

table for all report sample points. 

 Compliance Include a compliance summary. 

 Index Include a report table of contents. 

  AAS Summary Includes a single AAS Program 

summary table which contains Batch 

report details. 

 Start Time Select the report start time.  

The correct date and time are set up in the adjacent time and date 

fields when an option is selected. The options are: 

 Previous Hour  Starts 1 hour before the current time.  

 Previous 4 Hours  Starts 4 hours before the current time.  

 Previous 24 Hours  Starts 24 hours before the current time.  

 Previous 2 Days  Starts 2 days before the current time.  

 Previous Week  Starts 1 week before the current time.  

 Previous 2 Weeks Starts 2 weeks before the current time.  

 Previous 4 Weeks Starts 4 weeks before the current time.  

 Time of Day Today Uses the current date and time as the start 

time. Allows editing time if required.  

 Time of Day 

Yesterday 

Uses the current time with yesterday’s date as 

the start time. Allows editing the time if 

required.  

 Exact Date-Time Enables both the adjacent time and date fields 

for editing.  

 The exact start date and time required can be entered. 
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 Option Description 

 End Time Select the report end time.  

The correct date and time are set up in the adjacent time and date 

fields when an option is selected. The options are: 

 Current Date-Time End time is set up as the current date and time. 

This is displayed in the adjacent time and data 

fields. 

 Time of Day Today Uses the current date and time as the end time. 

Allows editing time if required. 

 Time of Day 

Yesterday 

Uses the current time with yesterday’s date as 

the end time. Allows editing the time if required. 

 Exact Date-Time Enables both the adjacent time and date fields 

for editing. 

 The exact end date and time required can be entered. 

 CSV File Folder Check this to enable the generation of tabular results as CSV (comma 

separated variable) files. The directory to write the CSV files to can 

also be selected. CSV files can be read by spreadsheet programs. 

 Add Sign Off 

Table 

Add a sign off table with the specified number of signature spaces to 

the report. 
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Sample Points and AAS Sample Points  

 
 

 Option Description 

 Sample Point Table The sample point table displays the Sample Points and 

Items to be included in the report. Use the Add and 

Remove buttons to populate the table as required. 

 Add/Add 

All/Remove 

Add, add all or remove sample points to the report. 

 Use Weighted 

Statistics 

When checked, the mean, standard deviation, and 

confidence limits will be calculated utilizing the sampling 

interval in use when each sample value was taken. The 

statistics table in the report will display weighted values. 

 Calculate MKT If selected, Mean Kinetic Temperatures will be included in 

the statistics tables for sample points which are configured 

with the MKT option.  
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Graph Plots  

 

 Option Description 

 Graph Plots Table Displays the Sample Points and Items to be included in the 

report. Use the Add and Remove buttons to populate the 

table as required. 

The Color column permits selection of line colors. 

The Graph column permits specifying which graph plot a 

sample point is to be displayed on. This is useful if there 

are many graph plots selected. 

The Grouping column permits placing more than one graph 

on a page, a maximum of three per page is advised. 

 Add/Remove Add or remove sample points to the report. 

 Plot Add-ons Specifies additional plot items to be added into the report. 

 Plot Options Specifies Plot mode and Scaling for the plot to be included 

in the report.  

Scaling Select linear or logarithmic scaling for 

all graphs. 

Legend 

Position 

Select Top, Left, Bottom, or Right to 

position the legend on the graph. 
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Logs and Messages  

 

 Option Description 

 Include Logs Select if log data should be generated in the report. The Log 

options are: 

 Alarm Log Data includes details of alarms and 

acknowledgements. 

 Warning Log Data includes details of warnings. 

 Audit Log Data includes details of user activity.  

 Trace Log Data includes diagnostic trace messages from the 

selected monitoring system.  

 Event Log Data includes system events.  

 Order Log By 

 

 

 

If a log is selected, provides options for ordering the data in the log 

tables. The options are: 

Time Date  

Source, Time Date 

Source, Messages  

 Filter Log By Filter the log results by the selected equation. An equation is 

comprised of the filter column (Time Date, Source, or Messages), an 

operator and a value. 

 Sample Points 

only 

If selected, only Log events relating to report sample points will 

be included. 
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Schedule Reports  

Scheduled Report allows setting up reports to be automatically generated 

without user invention.  

 
 

 Field Description 

 Generation 

Frequency 

Provides options for report scheduling frequency.  

 At Set the exact time for the report to be generated.  

 From Set the starting date for report generation.  

 Send Report To Specifies whether the report is to be generated as a pdf file 

or printed or both.  

 PDF File Select to generate report and save as a pdf file. The pdf 

filename will be the same as the report name.  

 CSV File Select to generate a csv file of the report data. Csv files will 

be saved in the csv file folder specified in the Report 

Details setup. 

 Printer Select option to print the generated report.  

 Printer Setup Select to set up the printer settings for the 

scheduled report.  

 Scheduled Report 

Options  

Select what should be included in the report.  

 Add Comments 

Box 

Select to add a comments box to the generated report.  
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 Field Description 

 Add Graphs Select to add graphs to the generated report.  

 Add Statistics Select to add Statistics tables to the generated report.  

 Add Tables Select to add sample point data tables to the 

generated report.  

 Add Compliance 

Summary 

Select to add compliance summary tables to the 

generated report.  

 Graphs In 

Landscape  

Select to display graph in landscape page.  

 Add Signoff Table Select to add a signoff table to the generated report. When 

selected the signatures field is enabled.  

 Signatures Set the number of signature fields required.  

 Email PDF To Select option to enable emailing of the generated pdf file.  

 Email Address 

Book 

Select the Email addresses to which the pdf file is to 

be sent.  

A A S  S t a t u s  

     or      

 

FMS can generate, edit, start and abort AAS Programs from the AAS Status 

screen. Rights to execute these functions can be managed via FMS 

Security Page. 

 
 

For detail on the operation of this screen please follow technical note 

TCC-187. 
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C o n t r o l l i n g  a  M o n i t o r i n g  S y s t e m   

To control an FMS system, appropriate permissions are needed for the node 

to be controlled. It is possible for different clients to try and control a given 

monitoring system's node at the same time. For this reason it is preferable to 

have only one administrator per monitoring system.  

 

To control a particular monitoring system, select either the monitor node then 

click Node -> Control or click the control button on the tool bar. This function 

is only available to those with the Can Control Nodes privilege.  

The control window allows for the monitoring system to be stopped and 

started as well as diagnostic tracing enabled.  

The Units recipe table displays the Unit name, the choice of recipes for the 

unit, and what the current unit recipe is. The sample point recipe table and 

the alarm group recipe table have the same columns as the unit table.  

The recipe list includes the standard options listed in the table below.  

 

 Option Description 

 Alarm Group Recipe Configure the recipe for each alarm group. 

 Unit Recipe Configure the recipe for each unit. 

 Sample Point Recipe Configure the recipe for each sample point. 

 Control Current Node Control current node. 
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Functions 

The buttons on the control panel have the functions listed in the table below. 

These functions require the entry of the username and password used to log 

into the selected node.  

 Icon Icon Name Description 

 
 

Stop 

Monitoring 

Monitoring is stopped. No data 

is collected. 

 
 

Start 

Monitoring 

The configuration files are loaded and 

monitoring restarts. 

 Update 
 

Update The configuration files are reloaded, 

and monitoring is restarted.  

 Restart 
 

Restart The monitoring node is stopped, the 

configuration files are reloaded, and 

monitoring is restarted using the 

Default recipe.  

 Start Trace… 
 

Start Trace Tracing is started. Trace messages 

from the selected monitoring system 

are broadcast to all clients. Although 

this is simple, it can slow down the 

network so this should only be used as 

a diagnostic tool to identify problems. If 

so enabled, Trace messages are 

saved to the selected file. Trace 

messages are also saved to the 

selected monitoring system's trace log 

database table, which in turn can be 

viewed using the Log Reports function. 

If the Log to File is set, the trace text 

is logged to the selected file.  

 Stop Trace 
 

Stop Trace Tracing is stopped.  

 Apply Selected Recipe 
 

Apply 

Selected 

Recipe 

Allows starting the selected recipes.  

 Apply All Recipes 
 

Apply All 

Recipes 

Allows applying all currently 

selected recipes.  
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M o n i t o r i n g  T a s k   

The monitoring task is a server application that runs without a user interface. 

It communicates with FMS client applications via a TCP/IP network. 

However, some diagnostic messages are generated for some database and 

communication problems. Under Microsoft® Windows® the supplied Debug 

Viewer can be used.  

 

Usually the monitoring task is started as a background process when the 

operating system starts. Under Microsoft® Windows® operating system the 

supplied utility Guard is used to start and stop the monitoring task as a 

Windows® service.  
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C H A P T E R  7  
SQL Server  

I n t r o d u c t i o n  

FMS stores all results and messages in SQL Server® databases. It is 

possible to have one SQL server per monitoring system, running on the 

same computer as the monitoring system, or on another computer.  

Alternatively, more than one monitoring system can use the same SQL 

server but different databases on the SQL server. This has the advantage of 

simplifying archiving and application management, but there is a risk of 

being a single point of failure. The converse is true when each monitoring 

node has its own SQL server, the administration is more complex but the 

overall system is more robust and fault tolerant.  
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C H A P T E R  8  
Modules  

Modules are loadable parts of the FMS program which provide functionality 

to the FMS client and monitoring programs. Without these modules, FMS 

would only have the top-level client display, the client configuration, and the 

control panel function. Some modules only provide functions to the client 

application, some only to the monitoring task, and others to both.  

The modules used by any given computer system are configured in the 

Modules section of the Client Options settings. This allows only required 

functions to be used.  

 

 

 

 

 

(continued on next page) 
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B a t c h  M a n a g e r  

The Batch Manager is an extension module that allows associating events 

with time.  

 

A batch will typically consist of several events and these events can be used 

to generate reports for the batch.  

 

The Batch Manager reads its data from the monitoring node database and 

writes to the database when saving changes. The Batch Manager performs 

a user validation check before committing changes to the database.  

 
 

The Batch Manager window shows a Batch List and Batch Events table.  

 

The Batch List is a list of all the batch names found in the database. Clicking 

on a batch name results in the event table being updated with the events for 

the selected batch.  

 

Users with the required privileges can add, edit, or delete batches 

and events.  
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Batch List Functions 

The buttons below the Batch List table have the functions listed in the table 

below. These functions require the entry of the username and password 

used to log into the selected node.  

 

 Function Description 

 
 

Displays a text dialog for entering the batch name. When OK 

is clicked and user is verified, the batch name is added to the 

batch list.  

 
 

Displays a text dialog for editing the currently selected batch 

name. When OK is clicked and user is verified, the new batch 

name will replace the old name.  

 
 

Displays a Confirm Delete dialog. When OK is clicked and 

user is verified, the selected batch name is removed from 

the list.  

 
 

The Find button is only enabled if text is entered in the 

provided box for searching. If clicked, it searches the batch 

list for the entered search text and when found, selects the 

batch in the list. 

Batch Event Functions 

The buttons below the Batch Events table have the functions listed in the 

table below. These functions require the entry of the username and 

password used to log into the selected node.  

 

 Function Description 

 
 

Displays a dialog for adding the batch event. When OK is 

clicked and user is verified, the batch event is added to the 

batch events table.  

 
 

Displays a dialog for editing the currently selected batch 

event. When OK is clicked and user is verified, the edited 

batch event will replace the old batch event.  

 
 

Displays a Confirm Delete dialog. When OK is clicked and 

user is verified, the selected batch event is removed from the 

events table.  

 
 

Prints the contents of the events table.  
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Batch Reports 

If Batch Manager is in use, it is possible to set up reports using batch names 

and events to define the start and end time of reports by selecting the Report 

Type to be BatchReport.  

 

N e t w o r k i n g  

Overview 

FMS uses TCP/IP for communications between tasks. TCP/IP 

communications can take several forms: connection-based, where there is a 

permanent connection between the client server, or connectionless, where 

there are no permanent connections between the client and server. The 

server tells the client when there is new data or when some event has 

occurred, and the client responds accordingly. 

Connection-based systems have the advantages of robust bi-directional 

communication, which means data can be sent between client and server 

with certainty that the data has been delivered over an active connection, or 

an error is reported. However, connection-based systems require more 

resources than connectionless systems and need some prior knowledge to 

use. In particular the host names of servers must be known beforehand. 

Connectionless systems have the advantage of lower resource usage and, 

by using a broadcast mechanism, can to some extent auto detect all 

components in a system to automatically configure itself. The disadvantage 

of using a connectionless communication system is that there is no certainty 

that data will be delivered, so extra protocols are needed to confirm that data 

is transferred correctly. 

FMS uses both types of communication in such a way to exploit the good 

sides of each type of protocol but to avoid the drawbacks. FMS uses 

broadcasts from the server and clients to notify system components of 

events and to self-configure. When transferring data between applications, 

short-life connections are made similar to HTTP. By using broadcasts, FMS 

applications can talk to any number of clients on the network with minimum 

effort. Although this makes it easy to build multiple node monitoring systems, 

there is the drawback that broadcast data packets are blocked by TCP/IP 
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routers. This means that FMS only works within a well-defined local network 

and cannot work over the Internet without the use of additional programs. 

This gives the benefit of security at the cost of distribution ability. 

Setting up a Network for FMS 

When setting up a TCP/IP network, ease of configuration and 

administration as well as security and resistance to node failure are the 

main considerations. 

By choosing a network address of 192.168.0.x with a subnet of 

255.255.255.0 up to 223 nodes (computers) can be networked together. 

Further by using a 192.168.x.0 network access to or from the Internet (other 

than through a proxy server) is not possible. It is possible for one computer 

to be connected to more than one network. This could be the monitoring 

system network and to the company network.  

By choosing network addresses carefully and avoiding IP forwarding, the 

monitoring system can be isolated from the company network. Further the 

use of broadcast protocols makes access from external networks difficult.  

It is important that the routing tables are correctly configured. Otherwise, 

client-to-server connections will not work correctly. The most common 

effect is that the clients can detect monitoring nodes but cannot obtain the 

node's configuration.  

The computer host names should be as short as possible (i.e., eight 

characters) and made up of English letters or digits with no spaces or other 

characters. The host name is used to access some files so keeping it simple 

makes life easier. Be aware that Linux® and other UNIX®-type operating 

systems are case sensitive whereas Microsoft® Windows® operating system 

is not case sensitive, although it will “honor” the case of filenames when they 

are created and copied.  

Refer to the operating system's documentation for more information.  

Broadcast Addresses 

The broadcast address is the UDP port used to send messages from 

applications to all other applications. Each server reserves its own TCP and 

UDP port for specific client-server transactions. It is important to use a UDP 

port that does not conflict with any others that are in use. Utilities such as 

“netstat” can be helpful. A port such as 4001 is usually free.  

Because clients only recognize servers that use a particular broadcast port 

number, it is possible to have more than one monitoring system sharing the 

same network, working independently of one another.  
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Remember broadcast data packets are not always forwarded across 

routers. This can be both an advantage and a disadvantage. It is an 

advantage because access to the monitoring system from outside a well-

defined network is not possible so the system is more secured. But a 

disadvantage for the same reason where access is required from clients 

outside the local network.  

DHCP or Static Addresses 

A static IP address will fix the network address of a computer so that it 

remains the same regardless. For small networks this is very simple to do 

and means specific computers can be identified by IP address alone. Also, 

using static IP addresses means the network configuration of a computer 

does not depend on any other computer system such as a DHCP or BIND 

server, so it will be immune to failures of other computer systems. The 

disadvantage of statically configuring a computer is that for large networks, 

administration becomes difficult and the possibility of mistakes that can stop 

a network functioning becomes more likely.  

Using DHCP (with a name server) makes configuring individual systems 

easy, albeit with some initial effort needed when setting up the DHCP and 

BIND servers. However, there is the disadvantage that the DHCP and BIND 

servers become single points of failure. If the DHCP or BIND servers fail, the 

whole system can fail, in particular when a node tries to start and set up its 

network address.  

If the monitoring system is required to withstand component failure and 

continue to function, a compromise strategy may have to be followed where 

the computers that are used for monitoring and as SQL servers use static IP 

addresses and clients use DHCP.  
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C H A P T E R  9  
Contact ing Customer  
Serv ice  

This chapter gives directions for contacting people at TSI® Incorporated for 

technical information.  

T e c h n i c a l  C o n t a c t s  

For help setting up or operating the FMS software, or technical or application 

questions, contact an applications engineer at TSI® Incorporated, 1-800-680-1220 

(USA) or (651) 490-2860 or e-mail technical.services@tsi.com.  

International Contacts 

Technical Support 

TSI GmbH 
Neuköllner Strasse 4 
52068 Aachen 
GERMANY 
 
 

Telephone:  +49 241-52303-0 
E-mail: tsigmbh@tsi.com 

TSI France Inc. 
Hotel technologique 
BP 100  
Technopôle de Château-Gombert 
13382 Marseille cedex 13 
FRANCE 

Telephone:  +33 (0) 1 41 19 21 99 
E-mail: tsifrance@tsi.com 

TSI Instruments Ltd. 
Stirling Road 
Cressex Business Park 
High Wycombe, Buckinghamshire 
HP12 3ST 
UNITED KINGDOM 

Telephone:  +44 (0) 149 4 459200 
E-mail: tsiuk@tsi.com 

TSI Instruments Singapore Pte Ltd 
150 Kampong Ampat 
#05-05 KA Centre 
SINGAPORE 368324 
 
 

Telephone:  +65 6595-6388 
Fax:  +65 6595-6399 
E-mail:  tsi-singapore@tsi.com 

mailto:technical.services@tsi.com
mailto:tsigmbh@tsi.com
mailto:tsifrance@tsi.com
mailto:tsiuk@tsi.com
mailto:tsi-singapore@tsi.com
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TSI Instrument (Beijing) Co., Ltd. 

Unit 1201, Pan-Pacific Plaza 

No. 12 A, Zhongguancun South Avenue 

Haidian District, Beijing, 100181  

CHINA 

Telephone:  +86-10-8219 7688 
Fax:  +86-10-8219 7699 
E-mail:  tsibeijing@tsi.com 

 

  

 

mailto:tsibeijing@tsi.com


 

 

Reader ’s  Comments  

Please help us improve our manuals by completing and returning this questionnaire to the address listed in the 

“About This Manual” section. Feel free to attach a separate sheet of comments. 

 

Manual Title     FMS Software User’s Manual                                              P/N 6002773   
 

1. Was the manual easy to understand and use? 

  Yes             No 

 

 Please identify any problem area(s)  _________________________________________________________  

 _______________________________________________________________________________________________  

 _____________________________________________________________________________________  

2. Was there any incorrect or missing information? (please explain)  __________________________________  

 _____________________________________________________________________________________  

 _____________________________________________________________________________________  

3. Please rate the manual according to the following features: 

  Good Adequate Poor 

 Readability    

 Accuracy     

 Completeness (is everything there?)     

 Organization (finding what you need)    

 Quality and number of illustrations     

 Quality and number of examples     

 Comments:  ____________________________________________________________________________  

 _______________________________________________________________________________________________  

 _____________________________________________________________________________________  

4. Which part(s) of this manual did you find most helpful?  __________________________________________  

 _______________________________________________________________________________________________  

 _____________________________________________________________________________________  

5. Rate your level of experience with the product: 

  Beginning   Intermediate   Expert  

6. Please provide us with the following information: 

 Name  _________________________________ Address   _________________________________  

 Title  __________________________________    _________________________________  

 Company  ______________________________    _________________________________ 



 

 
 
TSI Incorporated – Visit our website www.tsi.com for more information. 
 
USA Tel: +1 800 680 1220 
UK Tel: +44 149 4 459200 
France Tel: +33 1 41 19 21 99 
Germany Tel: +49 241 523030 

India Tel: +91 80 67877200 
China Tel: +86 10 8219 7688 
Singapore Tel: +65 6595 6388 
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